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Welcome to 
TurningPoint

TurningPoint enables you to take an ordinary PowerPoint slide show and create an interactive 
presentation. With TurningPoint’s many customizable features you can conduct a presentation, 
collect your audience’s responses, and then save those session results. The tools that TurningPoint 
provides allows you to import slide shows, run reports and export your session data. 

TuringPoint allows you to interchange charts, use pictures as answers, and add Countdown Timers 
and Correct Answer Indicators. TurningPoint offers additional features including:

Enhanced Response Device
Detection

TurningPoint’s Enhanced Response Device Detection... 

• Provides Plug and Play capabilities for Response 
Innovation’s USB Receivers  

• Allows you to predetermine and set Channels when 
presentations are being conducted in multiple adjacent 
rooms

User Friendly Settings and
options allow for a  Personal

Experience

With the settings interface, you can:

• Use the Settings Hierarchy to personalize the 
Application, Response Devices, Presentation-level, 
Slide-level and Answer-level settings

• Use drop-down menus to change many of the settings

• Review a detailed description of each setting

• Set an answer as Correct/Incorrect or assign a point 
value

• Clear the value for an answer
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Welcome to TurningPoint

Built-in Testing Standards With Built-in Testing Standards, you can choose standards by: 

• State (choose from all 50 states)

• Type

• Subject 

• Grade

TestingPoint 2008 Support TestingPoint is a Microsoft Word add-in that allows users to create 
self-paced tests. TurningPoint allows users to import TestingPoint 
documents to create an interactive presentation.

Participant List Features Participant Lists allow you to create predefined audience lists 
allowing you to gather session information by participant or 
response device. With the Participant List, the Device ID field is 
automatically added when you create a new list. Additionally, you 
can:

• Add/Remove Fields, such as Class or Company, from the 
Participant Information Screen 

• Allow audience members not in your Participant List to 
participate in a presentation

Turning Reports With the reports interface, you can easily review the results of your 
TurningPoint session in reports.

The following chapters in this guide demonstrate how to implement 
these new features to make the most of your presentation.
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About 
TurningPoint

Welcome to TurningPoint, the easiest, most powerful, fully interactive group response system 
available. Designed to be used with PowerPoint, TurningPoint enables two-way communication 
between a speaker and a large group by allowing audience feedback. TurningPoint offers the ability to 
collect, evaluate, and record responses from everyone in the audience, transforming a lecture, 
workshop, or meeting into a more effective learning environment for everyone in the room. By 
engaging each participant, TurningPoint creates a unique session every time, recording response 
data that can be used immediately or later for grading, polling, attendance tracking, and demographic 
research.

Whether you want to gauge an audience’s opinion or quickly assess your students’ understanding on 
important points in a lecture, TurningPoint enables you to ask and receive a response at the very 
moment you want to ask most. The audience uses response devices to submit answers to questions 
you have created. Then, TurningPoint gathers responses from each participant and quickly translates 
them into measurable results in the form of test scores, charts, and graphs. 

After a presentation, TurningPoint helps you store the data for later access or for use in reporting or 
grading.

This chapter provides an overview of the product and its capabilities and includes the system 
requirements, the steps for installing TurningPoint on your computer, and some resources available to 
you for customer support.
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Chapter 1: About TurningPoint

Product Introduction

TurningPoint smoothly integrates with PowerPoint to create a more interactive and memorable 
presentation. TurningPoint was designed to run on a computer running Office 2004 for Mac with Mac 
OS X 10.3 or higher support. (Find additional information in System Requirements on page 9.) All 
TurningPoint options are accessed through the TurningPoint toolbar.

The TurningPoint toolbar can be found in PowerPoint beneath the standard PowerPoint toolbar after 
TurningPoint is installed. This toolbar offers you all the options you need to create interactive slides, 
set up and run a presentation, and generate reports. Easy-to-use features such as the Participant List 
Assistant helps to you get started quickly. 

Other TurningPoint features include participant monitoring and reporting tools. TurningPoint also 
provides the ability to use Turning Technologies’ TestingPoint to streamline the creation of Participant 
Lists and reporting of classroom results and grades.
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System Requirements

System Requirements

TurningPoint is designed for use on computers with typical abilities. You do not need the very latest 
technology or a large amount of hard disk space to use TurningPoint. There are, however, a few 
requirements that you should check before installation. The requirements for hardware and software 
are detailed in the following sections.

Requirements for Hardware

The following hardware specifications are required before installing TurningPoint:

• G3 processor or better / Intel processors fully supported (Universal Binary)

• 256 MB RAM (512 MB recommended)

• 10 MB hard disk space 

• Available USB 1.1 or USB 2.0 port 

Requirements for Software

The following software applications are required to take full advantage of TurningPoint capabilities:

• Mac OS X 10.3 or higher 

• Microsoft Office 2004 for Mac 
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Initial Setup

There are two easy steps that need to be completed before you begin using TurningPoint. This 
section will guide you through those steps.

This section describes how to:

• Install TurningPoint 
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Install TurningPoint

Install TurningPoint

In a few simple steps, TurningPoint can be installed on your computer. The installation process takes 
just a few minutes, and then you will be ready to create a TurningPoint presentation.

Before You Begin

Check the hardware and software specifications outlined in System Requirements on page 9. A 
computer must meet these system requirements before installation.

Step by Step Instructions To install TurningPoint software on a computer…

1 Install TurningPoint in one of 
two ways:

• Download the latest 
edition of TurningPoint 
from the Turning 
Technologies web site. 

The Turning Technologies web site is located at 
http://www.turningtechnologies.com. Complete the 
download request form and Turning Technologies sends 
an email with download instructions. When the download 
is complete, double-click on the DMG file to begin the 
installation process.

• To install from a CD, insert 
the CD into the computer.

After you insert the CD, double-click on the disc that 
displays on the desktop to begin the installation process.

2 If an older version of 
TurningPoint is installed, a 
message displays requesting 
you to uninstall the previous 
version. 

If this is the first time you are installing TurningPoint or have 
already removed a previous version, continue with step 3.

See Mac Help file for instructions on uninstalling a previous 
version. Resume process at step 1.



12 Turning Technologies

Chapter 1: About TurningPoint

3 Select the Continue button to 
continue the installation.

A window opens and displays the license agreement. Use the 
scrollbar to read the license agreement on the screen or select 
the Print button to send the text to a printer. 

License Agreement

4 Select Continue. A license agreement window opens. 

Agree/Disagree with License Agreement

5 Select Agree if you accept 
these terms.

Accepting the terms of the license agreement permits you to 
continue with the process of installing TurningPoint. 



TurningPoint User Guide 13

Install TurningPoint

A window opens and allows you to choose the installation 
destination.

Choose Destination

6 Choose the installation 
destination and select 
Continue.

A window opens and displays a confirmation message stating 
that the computer is ready to install TurningPoint.

Install the Program
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7 Select the Install button. The computer installs TurningPoint and displays the Close 
button on the page when the process is complete. 

Installation Completed

8 Select the Close button. A window opens and displays a message that the installation is 
complete. 
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Tour of the TurningPoint Toolbar

Tour of the TurningPoint Toolbar

When you launch TurningPoint, PowerPoint opens and the TurningPoint toolbar is displayed beneath 
the PowerPoint standard and formatting toolbars in the upper region of the window, as the following 
image depicts.

TurningPoint Toolbar

The following descriptions define the buttons that make up the tools in the TurningPoint 2008 toolbar: 

Information Allows you to view information 
about your TurningPoint 
License. 

Reset Displays a menu of options to 
clear the current user response 
data to start a new session or 
reset individual slides for 
polling. Find information about 
polling the audience in 
Chapter 7: Run 
Presentations.

Continue Prior 
Session

Opens a previously saved 
session. A session is a run-
through of a presentation 
where an audience has 
submitted responses to some 
or all of the questions. Find 
information about continuing a 
prior session in Chapter 9: 
Sessions. 

Save Session Stores the current session for 
retrieval later. Find information 
about saving sessions in 
Chapter 9: Sessions.

Refresh Current 
Slide

Implements the changes that 
have been made to the slide on 
which you are currently 
working.
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Insert Slide Displays a menu of 
TurningPoint slides that you 
select to create a presentation. 
Find information about 
TurningPoint slides in Chapter 
3: Creating and Saving 
Slides.

Convert to 
Picture Slide

Assigns pictures as answers 
instead of text. Find 
information about picture slides 
in Chapter 3: Creating and 
Saving Slides.

Insert Object Displays a menu of items that 
you select to enhance a slide. 
Find information about slide 
options in Chapter 3: Creating 
and Saving Slides.

Tools Displays a menu of options to 
report, modify, track, create 
and integrate TurningPoint 
presentations and sessions.

Select Input 
Source

Selects the input source to be 
used for collecting response 
data. These include Response 
Devices and Simulated Data. 
Find information about 
response devices in Chapter 
4: Response Device and 
Settings Management.

Participants Provides options to create, edit 
and delete Participant Lists. 
Find information about these 
options in Chapter 5: Track 
Participants.

Select a 
Participant List

Assigns a Participant List to a 
session. Find information 
about participant lists in 
Chapter 5: Track Participants.

Start a 
TurningPoint 
SlideShow

Starts your interactive 
presentation.
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Customer Support Resources

This guide defines and demonstrates many of the tools and functions that TurningPoint provides. If 
you have questions and concerns, additional resources are available to you online or by calling a 
Turning Technologies Representative. 

Online Assistance

Turning Technologies offers assistance to customers online through the Turning Technologies web 
site. To access the web site, go to http://www.turningtechnologies.com.

Go to the Product Guides and Manuals section of the Turning Technologies web site to find valuable 
information about using TurningPoint. The Downloads section provides a link to the Quick Start 
TurningPoint Users Guide. Select the link to download the user guide for viewing or printing. 

Go to the Learning Community section of the Turning Technologies web site to find training 
information including:

• Tutorials

• Online Training

• On-site Training 

• Case Studies 

• Best Practices 

• Presentations/Podcasts 

Customer Support

To speak with a Turning Representative, call our toll-free phone number: 1-866-746-3015. By E-mail, 
send your inquiry to support@turningtechnologies.com.

Office Hours:

Monday through Friday, 7:00 AM to 9:00 PM (EST)
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Mailing Address:

Turning Technologies, LLC
241 Federal Plaza West
Youngstown, OH 44503

Turning Technologies, LLC offers complete TurningPoint training. Our trainers are ready to hit the 
road to fulfill your training needs at your location. Or if you desire, send your team to our state-of-the-
art training facility in Ohio. 

Typical training sessions last from two to six hours depending on your intended use of TurningPoint 
and skill level with Microsoft Office products. For Training Services, call 1-866-746-3015 for details.
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Where Do I Go From Here?

Where Do I Go From Here?

If you are new to TurningPoint, this manual will help you on your way. Read through Chapter 2: 
Getting Started with TurningPoint to receive a general overview of working with this product. 

Are you a returning user? Details of the new TurningPoint features can be found throughout this 
document. Welcome to TurningPoint on page 5 outlines these new features, while the Table of 
Contents or Index should help you find them quickly.
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Getting Started 
with 
TurningPoint

The process to create interactive presentations with TurningPoint is very simple. You can successfully 
build, deliver, and save the results of an interactive presentation in five easy steps.

From there, with a little more effort, you can customize the slides and include animation, feedback 
mechanisms, and excitement in your presentation. You can also create reports to view the results of 
your presentation session.

This chapter provides the basics, a tutorial of sorts, for using TurningPoint. Following the five steps to 
success allows you to create very simple interactive presentation slides, set up the devices, create a 
Participant List, and use TurningPoint to present those slides. 

The advanced features of TurningPoint are detailed in the chapters that follow. You can find 
information about the contents of those chapters in Where Do I Go From Here? on page 44.
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Five Steps to Presentation Success

Creating an interactive presentation with TurningPoint can be accomplished in five easy steps. 

Five Steps to Success

As the previous diagram depicts, you start by creating the presentation slides. These slides can be as 
simple or complex as you desire. You can use PowerPoint’s features to apply a background, insert 
graphics, etc. to meet your needs. You will repeat this step many times as you create additional 
TurningPoint interactive slide presentations.

Next, plug the devices into your computer to be used during the presentation and you are ready to 
gather responses from the audience. You can go to the Polling Test found in Chapter 4: Response 
Device and Settings Management to test communication or skip the test and go to the next step. 
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Five Steps to Presentation Success

Identify your audience. Create a Participant List using the Participant List Wizard. You can choose 
from using standard list templates or create one of your own to store as much information about your 
audience as required. You can also run a presentation without a Participant List or create a 
Participant List for each audience.

When that’s done, you are ready to run the presentation. You’ll use PowerPoint’s Slide Show 
functionality for this purpose. Behind the scenes, TurningPoint is gathering, tallying, and storing the 
responses provided by your audience.

Finally, save the results of your session in a file to be used with TurningPoint’s reports to evaluate the 
audience’s responses. Perform this step for each presentation session.

Instructions to perform these five steps to success are detailed in the following sections. Instructions 
to use the advanced features of TurningPoint are found in the chapters that follow. 

This section describes how to:

• Step One: Create Presentation Slides

• Step Two: Set Up the Response Devices

• Step Three: Create a Participant List

• Step Four: Run a Presentation Session

• Step Five: Save Session Results
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Step One: Create Presentation Slides

Using TurningPoint to create an interactive presentation requires some basic PowerPoint knowledge 
and your imagination. Your slides can simply contain question and answer text, or you can add 
TurningPoint objects to each slide to allow your participants to interact effectively with your 
presentation. TurningPoint’s objects include answer reminders and timers.

Before You Begin

Install TurningPoint on the machine to be used to run the presentation. Find installation instructions in 
Install TurningPoint on page 11.

You should be familiar with the basics of creating slides using PowerPoint. This manual discusses 
how to use TurningPoint to create interactive presentation slides.

Step by Step Instructions To create a simple slide…

1 From the TurningPoint 
toolbar, select the Insert Slide 
menu. 

A menu opens and displays a variety of pre-defined slides. Each 
slide can be used as-is or customized to behave as you desire.
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Step One: Create Presentation Slides

As you move your cursor over the entries in the Insert Slide 
menu, the slide name is highlighted. Find more information on 
slides in Types of Slides on page 56.

Insert Slide
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2 Highlight and select the 
Vertical Slide option.

TurningPoint inserts a Vertical Slide. The slide contains a 
question, answer, and chart region.

Insert Vertical Slide

3 Select and highlight the text 
in the Question region and 
enter in a question.

The highlighted text is replaced with the question text that you 
enter.

4 Select the answer region and 
enter in the answers.

This region has the same behavior as the Question region. You 
can enter a maximum of ten answers per slide.

Question region - “Enter question text...”

Answer region - “Enter answer text...”

Chart region - This example is a vertical bar 
chart. Charts can be positioned anywhere on the 
slide.
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Step One: Create Presentation Slides

5 Repeat step 1 to 4 to insert 
additional slides.

6 Save your file from the 
PowerPoint toolbar before 
exiting TurningPoint.

Next Steps

Slides can be customized by adding a variety of animated feedback mechanisms. Find information 
about these different presentation objects and a variety of other slide features in Chapter 3: Creating 
and Saving Slides.
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Step Two: Set Up the Response Devices

Each audience participant uses a response device to respond to the questions asked during the 
presentation.

TurningPoint supports a variety of response devices including infrared and radio frequency 
ResponseCards as well as vPad, laptop and desktop computers.

TurningPoint needs to know what types of response devices will be used before you run the 
presentation. 

Before You Begin

You must have TurningPoint installed on the computer to be used for the presentations. You must also 
have the USB Response Device Receivers and Response Devices available for testing. 

Step by Step Instructions To set up the response devices…

1 Connect the device receiver 
to the USB port of the 
presentation computer.

Connect the USB Response Device Receiver to your computer.  
The device is now ready for use. 

Infrared and Radio Frequency Response Device Receivers

If you are using a response device licensed for TurningPoint 
2006, contact your Account Executive to receive a new license 
code.

Note TurningPoint 2008 supports only the 
ResponseCard family of keypads.
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2 If required, Upgrade your 
Response Device. 
Otherwise, go step 3.

If you have not already upgraded your response device 
receiver, you must complete this step. 

a. From the TurningPoint 
toolbar, select Tools > 
Upgrade TurningPoint 
Receiver. Follow the on 
screen instructions. 

3 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The TurningPoint Settings window opens, displaying two tabs: 
Settings and Polling Test. 

Settings Window

4 Select the Settings tab. The Settings tab displays a Settings Hierarchy in the left pane 
and the available settings in the right pane.
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5 Select Response Devices 
from the Settings Hierarchy. 

Settings for the Response Devices display in the right pane of 
the Settings window.

Settings Window: Response Devices

6 Enter the number of expected 
devices. 

You are only required to enter the number of expected devices 
when using Simulated Data.

7 Close the Settings Window. The response devices are ready for use. 

Note The vPad is a software version of a response 
device. The vPad must be identified for use 
during device setup as well. Find more 
information on device setup in Chapter 4: 
Response Device and Settings Management.

Note Access the Response Device settings again 
when you need to change the number or type 
of devices being used with your presentations.
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Step Two: Set Up the Response Devices

Next Steps

Find more information about Response Devices and the Settings available in Chapter 4: Response 
Device and Settings Management.

If an audience member’s device is not being accepted, check the device’s ability to communicate. 
Radio Frequency and vPad response devices provide on-screen confirmation that responses have 
been received. For infrared response devices, the use of a Response Grid will help to alert you of a 
non-communicating device. Find more information in View Polling Status on page 201.

Step by Step Instructions To Check Device Communication...

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The TurningPoint Settings window opens, displaying two tabs: 
Settings and Polling Test. 

Settings Window
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2 Select the Polling Test tab. TurningPoint displays the Polling Test screen. Use this screen 
to verify that TurningPoint can receive responses from the 
devices. 

Settings Window: Polling Test

3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices.
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4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, and the key entry from 
each response device in the order in which they were tested.

Polling Test: Response Device Test

5 Select the End Test button. TurningPoint ends Polling test. 

6 Close the Settings Window. The response device testing is now complete. 
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 Step Three: Create a Participant List

Participant Lists identify the members of your audience—your students, your trainees, your survey 
respondents—who will use a response device during your presentation. The participant name and 
required information is stored along with the Device ID.

You may create multiple Participant Lists to be used with one interactive presentation. Doing so 
allows you to use the presentation with multiple audiences and track the session results per audience.

Before You Begin

Your Participant List must not exceed the number of devices licensed for use. If you are not sure of 
the number, check the number of devices and then perform the following steps on the computer to be 
used for presentations after you setup your response devices. 

Step by Step Instructions To create a Participant List…

1 From the TurningPoint 
toolbar, select Participants > 
Participant List Assistant.

The TurningPoint Participant List Assistant  window opens.

Turning Point toolbar: Participants
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Step Three: Create a Participant List

2 Select a template to be used 
for the new Participant List.

Participant List Assistant

Participant List template choices include:

• Education—contains standard student information used 
for K–12 and higher education presentations, such as 
name and student ID.

• Corporate—contains entries for the information most 
often used in corporate feedback meetings including 
name, company name, telephone numbers, etc.

• All Available Fields—contains all information entries 
defined for use with TurningPoint.

• Blank—allows you to create a personalized Participant 
List and to name the template.

• Custom—allows you to select a previously created 
template from the list.

3 Select the Continue button. TurningPoint displays the Participant List information entries 
(called fields). All entries that make up the template appear in 
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the Selected Fields region on the right. Use this page to add, 
delete, or reorder the entries that make up the template.

Participant List: Add or Remove Fields

4  Optionally, drag and drop a 
field from the Available Fields 
to the Selected Fields. Note Find instructions to customize Participant List 

templates in Chapter 5: Track Participants.
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5 Select the Continue button. TurningPoint displays the Participant List summary screen 
displaying the file name and number of fields. 

Participant List Assistant: Summary

6 Optionally, edit the 
Participant File composition.

You can change the Participant List file name by entering a new 
name over the old one. Select the Go Back button to add or 
delete a field.

7 Select the Finish button to 
create the Participant List 
and save it to a file. 

TurningPoint opens the Participant Information window where 
you can type, Edit, or paste data. 
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8 Optionally, add names and 
other participant information 
to the new Participant List. 

Participant Information

9 Select Done to close the 
Participant Information 
window.

Next Steps

Find more information about Participant Lists in Chapter 5: Track Participants.
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Step Four: Run a Presentation Session

 Step Four: Run a Presentation Session

TurningPoint uses PowerPoint’s Slide Show capabilities to present the interactive slides you have 
created. You test your slides during development and run the presentation for your audience by 
executing the following steps.

Before You Begin

You must use either an installed Response Device Receiver, or select to use Simulated Data before 
attempting to run the presentation. It is recommended that you use a Participant List, but you can still 
run a presentation session by selecting Anonymous or Auto for the Participant List.

Step by Step Instructions To run a presentation session…

1 From the PowerPoint menu, 
select File > Open and select 
the TurningPoint 
presentation to be used.

2 From the TurningPoint 
toolbar, select the Response 
Device menu and select the 
device to be used.

TurningPoint allows you to select how responses will be 
provided during the presentation. Your choices are:

Select Response Devices

• Response Devices—a response device will be used 
during the presentation. The response devices must have 
been set up in Settings. Find more information on 
response devices in Install Devices on page 101.

• Simulated Data—TurningPoint provides random 
responses to the presentation. TurningPoint determines 
the number of responses to provide based on the number 
of expected devices designated in settings; i.e. if you 
enter expected devices as 100, TurningPoint will provide 
up to 100 responses to each question in your 
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presentation. Find more information on expected devices 
in Enable vPad on page 115.

3 From the TurningPoint 
toolbar, select Reset > 
Session.

This command clears any active sessions from memory and 
allows polling to take place.

Reset Session

4 From the TurningPoint 
toolbar, select the drop-down 
menu to the right of the 
Participants menu and 
choose the Participant List.

The default Participant List is shown as (Auto). TurningPoint 
shows all Participant Lists available in the Participants folder. 
Participant Lists located on the desktop or in other folders are 
not displayed. 

Participant List Selection

5 From the TurningPoint 
toolbar, select the Start a 
TurningPoint Slide Show 
button.

The currently selected slide of the presentation is shown.
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6 Use the mouse button to 
control the progress of the 
slide show. For each slide:

Optionally, you can press the N key, Return, Right Arrow, Down 
Arrow, Enter, or the Space Bar to control progress.

a Advance the presentation 
to a TurningPoint slide.

Polling must be opened by the presenter. 

b Select the play button on 
the Showbar to open 
polling.

TurningPoint receives responses when polling is open.

Polling is the mechanism by which TurningPoint accepts 
and tallies responses provided by the audience using the 
Response Devices. 

c  Select the stop button on 
the Showbar to close 
polling. 

TurningPoint displays the polling results. 

No responses are accepted when polling is closed.

d Click the slide to advance 
to the next slide.

Repeat steps a through c for each TurningPoint slide in 
your presentation.

7 Click on the last slide to exit 
from the Slide Show.

Next Steps

Your presentation may have additional features, such as animation, that cause it to behave differently 
at runtime from the default behavior. Find more information in Chapter 7: Run Presentations.
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Step Five: Save Session Results

TurningPoint stores the results from your session. These results can be reviewed at a later date and 
used with TurningPoint’s reporting feature in a variety of ways.

When you save a session, a default TurningPoint setting automatically includes the PowerPoint 
presentation with your TurningPoint file. 

The session results are stored temporarily during a session. You can save the session results to a file 
to access them later. This section provides instructions to do just that.

Step by Step Instructions To save the session results…

1 From the TurningPoint 
toolbar, select the Save 
Session button. 

Save Sessions

TurningPoint opens the Save Session dialog box.

2 Enter a file name to be used 
to store the session results.

TurningPoint names session files using the current system date 
and time. Providing your own name for the file allows you to 
retrieve the file more easily.
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3 Select the Save button.

4 From the TurningPoint 
toolbar, select the Reset > 
Session command.

TurningPoint clears the existing session results and allows you 
to run the presentation again to capture new results. 

Reset Sessions

Next Steps

You are able to run reports to review the responses provided by each participant for your 
presentation. The TurningPoint reports use the saved session file. Find more information on Turning 
Reports in Chapter 8: Reports.

Note TurningPoint prompts you to save existing 
session results when you reset the session and 
when you exit from TurningPoint without 
previously saving the session. 
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Where Do I Go From Here?

The answer to that question depends upon what you want to do. Following is a listing of the remaining 
chapters in this book along with information about what to find in each chapter.

Chapter Name Description

Creating and Saving Slides This comprehensive, instructional chapter provides details 
of not only how to create a slide, but also how to add 
TurningPoint’s custom features to the slide to meet your 
needs. 

Read this chapter to understand how to add objects such 
as Response Reminders and Correct Answer Indicators, 
how to set slide defaults, how to convert existing slides into 
interactive TurningPoint slides, and more.

Response Device and Settings 
Management

Device setup is easy. However, if you need more help than 
what is included in this Getting Started chapter, you’ll find it 
here.

Read this chapter for a comprehensive guide of the 
available settings and how they can help you create a 
presentation to meet your needs.

Track Participants Participant Lists can use the default templates or can be 
customized to include information according to your needs 
or requirements.

Read this chapter to understand how to create custom 
Participant Lists, how to create Groups, how to modify or 
delete a Participant List, and how to download participant 
information from other sources.

Tools The tools discussed in this chapter include how to set up 
standards for your slides and import slides.

Run Presentations Would you like to establish presentation session default 
behaviors? Have you included animation in your slides? 
Would you like to add slides during your presentation? 

This chapter focuses on the behavior of your slides during a 
Slide Show presentation and identifies how you, the 
presenter, interact with TurningPoint during a “live” session.
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Reports This chapter focuses on the various reports produced from 
a Slide Show presentation. These reports allow you to get a 
better understanding of the audience and presentation 
results.

Sessions You can stop and save a session, and pick up where you 
left off at a later time. This chapter will teach you how to 
save, resume, and delete a session to give you flexibility 
during your presentation.

Appendices The appendices include a Glossary and a guide to 
Frequently Asked Questions. 

Chapter Name Description
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Creating and 
Saving Slides

In Chapter 2: Getting Started with TurningPoint, you learned the basic steps for creating 
TurningPoint presentations. This chapter and the remaining chapters of this user guide demonstrate 
the steps in greater detail, allowing you to use all the powerful features TurningPoint offers.
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Recall the five steps to presentation success:

Five Steps to Success

As the previous diagram depicts, the first step is to create the presentation slides. This chapter 
demonstrates how to use TurningPoint to create the slides you will use later in a presentation.

TurningPoint slides are slides in a PowerPoint presentation with the ability to dynamically display 
information based on the responses of an audience. Most TurningPoint slides ask the audience to 
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answer a question, and then tabulate and display the responses. These slides have a question, 
answer, and chart region. 

Composition of a Typical Slide

The question region contains the text of the question you are asking the audience. The answer region 
contains an enumerated list of answers that the audience can choose from. (You can even use 
pictures as the answers. Find more information in Create Picture Slides on page 78.) 

The chart region shows the results of the audience’s choices, with a bar, slice, or other indicator for 
each answer (depending on the type of chart). There are  five types of charts available. Find more 
information in Chart Slides on page 57.

You start by creating some TurningPoint slides. You have two options:

• Insert a TurningPoint template slide using the Insert Slide menu in the TurningPoint toolbar. Find 
instructions for inserting a slide in Insert a Slide on page 51.

• Convert an existing PowerPoint slide into a TurningPoint slide by inserting a TurningPoint chart 
using the Insert Object menu in the TurningPoint toolbar. Find instructions for converting a 
PowerPoint slide in Make a PowerPoint Slide Interactive by Inserting a Chart on page 82.

Question region - “Enter question text...”

Answer region - “Enter answer text...”

Chart region - This example is a vertical bar 
chart. Charts can be positioned anywhere on the 
slide.
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Once you create the slides, you can modify them in a number of ways. You can add pictures, change 
colors, change the chart, mark correct answers, and perform other operations specific to 
TurningPoint. Find more information in Modify Slides on page 68.

Additionally, TurningPoint allows you to add a number of TurningPoint objects to your slides. These 
include Answer Now prompts and Countdown shapes and statistics like the average and variance of 
the responses. Find information on adding objects in Add Objects on page 84.

Your TurningPoint slides are saved as part of your PowerPoint presentation in your .ppt  file. Find 
information on saving your presentation in Save the Presentation Slides on page 54.
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Creating Slides

TurningPoint allows you to create and save an interactive presentation. 

This section describes how to:

• Insert a Slide

• Save the Presentation Slides

Insert a Slide

You can insert a TurningPoint slide using the Insert Slide menu.

Step by Step Instructions To insert a slide into a presentation…

1 Launch TurningPoint.

2 Open a presentation or 
create a new presentation.
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3 From the TurningPoint 
toolbar, select Insert Slide.

The Insert Slide menu opens. 

Insert Slide menu

4 Select the type of slide you 
would like to insert from the 
Insert Slide menu.

TurningPoint inserts the new slide into your presentation.

Depending on what type of slide you selected, the new slide 
may contain question, answer, and chart regions.
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Find information about the different slide types in Types of 
Slides on page 56.

Composition of a Typical Slide

Additionally, depending on your TurningPoint settings, the slide 
may contain an interactive shape such as an Answer Now 
prompt or Countdown. Find more information on adding or 
changing these objects in Add Objects on page 84.

5 Edit the text in the question 
region to reflect the question 
you would like to ask the 
audience.

Question region - “Enter question text...”

Answer region - “Enter answer text...”

Chart region - This example is a vertical bar 
chart. Charts can be positioned anywhere on the 
slide.
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6 Edit the text in the answer 
region to reflect the choices 
the audience will have when 
responding to the question.

You may enter up to ten answers in the answer region.

Repeat this procedure as many times as needed to create your 
interactive presentation.

Save the Presentation Slides

Since TurningPoint slides are native PowerPoint slides, they are saved as part of your presentation 
file (.ppt). You can share this file with other TurningPoint and PowerPoint users. 

Step by Step Instructions To save your presentation…

1 Select File > Save As… from 
the PowerPoint menu.

The Save As dialog opens.

2 Select a location to save the 
file and type a filename for 
the file in the space provided.

You should keep the.ppt  extension in the filename to ensure 
that PowerPoint opens the presentation file.

3 Select the Save button to 
save your file.

TurningPoint saves all of the presentation-level settings that 
you defined in the Settings menu with your interactive 
presentation. When you open the presentation on a different 
computer, the saved presentation settings are used instead of 
the computer’s default settings. This function preserves your 
custom settings so that you do not have to reapply them every 

Note You can safely open the presentation on 
computers without TurningPoint installed, 
but you cannot use the TurningPoint 
features. You should not edit the 
TurningPoint slides on a computer without 
TurningPoint installed. Otherwise, the slides 
may not function properly the next time you 
run your interactive presentation.
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time you open a presentation on a new computer with 
TurningPoint installed. Find more information on settings in 
Chapter 4: Response Device and Settings Management.

Note You can restore the computer’s settings 
when using any presentation. A Reset All 
Settings button displays in the bar below the 
settings options. Select this button and a 
dialog box opens with this statement: ‘Do 
you want to reset all settings to the default 
values?’ Select Reset to restore the default 
settings.
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Types of Slides

The Insert Slide menu on the TurningPoint toolbar lists all of the slides you can insert into a 
presentation.

Insert Slide menu

This section describes

• Chart Slides

• Template Slides

• Special Slides
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Chart Slides
The first set of five slides on the Insert Slide menu insert a template slide with a chart of the specified 
type: vertical, horizontal, 3D pie, distributed pie, offset, or doughnut. The chart shows the results of 
the audience’s choices for each answers.

Chart Slides Menu

The  five chart slides in the Insert Slide menu each contain the following:

• A Question Region with the text “Enter question text…”

• An Answer Region with the text “Enter answer text…”

• A Chart Region with a chart of the specified type: vertical, horizontal, 3D pie, distributed pie, offset, 
or doughnut

Charts are objects on the TurningPoint slide that can be moved and resized just like ordinary objects. 
You can change the type of chart on a TurningPoint slide by following the instructions in Change 
Chart Types on page 70.

Note Horizontal and Offset slides display Choice 
One, Choice Two, and etc. in the Answer 
Region.
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Vertical Slide The vertical slide contains a bar chart with vertical bars for each 
answer.

Vertical Slide

Horizontal Slide The horizontal slide contains a bar chart with horizontal bars for 
each answer. Each bar displays behind the corresponding 
answer in the answer region.

Horizontal Slide
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3D Pie Slide The 3D pie slide contains a three-dimensional pie chart with a 
slice for each answer and a key indicating the color representing 
each answer.

3D Pie Slide

Distributed Pie Slide The distributed pie slide is similar to the 3D pie slide except the 
slices are shown separated from each other.

Distributed Pie Slide



60 Turning Technologies

Chapter 3: Creating and Saving Slides

Offset Slide The offset slide contains a bar chart with horizontal bars for 
each answer. Each bar is shown directly below the 
corresponding answer in the answer region.

Offset Slide
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Template Slides
The  second set of slides on the Insert Slide menu are templates for commonly used kinds of 
questions, such as Yes/No, True/False, Yes/No/Abstain, Likert Scale, and Generic  Slides.

Template Slides Menu

When you insert any of the template slides, a Vertical chart is inserted onto the slide. You can change 
the chart type on the inserted slide. Find information for changing chart types in Chart Slides on 
page 57.

Yes/No Slide A Yes/No slide is used for a question with a yes or no 
response.The slide includes a generically worded question and 
answers. You may wish to edit the question to be more specific.

Yes/No Slide
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True/False Slides A True/False slide is used for a question with a true or false 
response. The slide includes a generically worded question and 
answers. You may wish to edit the question to be more specific.

True/False Slide

Yes/No/Abstain Slide A Yes/No/Abstain slide is used with a yes or no response with 
option to abstain. The slide includes a generically worded 
question and answers. You may wish to edit the question to be 
more specific.

Yes/No/Abstain Slide
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Likert Scale Slide A Likert Scale slide is used for a statement with a response of 
varying levels of agreement or disagreement. There are 4-, 5-, 
and 7-level Likert Scale slides. The slide includes a generically 
worded question and answers. You may wish to edit the 
question to be more specific.

Likert Scale Slide

Generic Slide A Generic 2 to 10 answer slide allows you to insert a slide with 
up to 10 answers. The slide includes a generically worded 
question and answers. You may wish to edit the question and 
answers to be more specific.

Generic Slide
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Special Slides
The final set of slides in the Insert Slides menu are special-purpose slides. There are several special-
purpose slides: ResponseCard RF Channel Slide, vPad Log-In, Fill in the Blank Slide, and Essay 
Slide.

Special Slides Menu

ResponseCard RF Channel
Slide

The ResponseCard RF Channel Slide displays channel setting 
instructions for the ResponseCard Radio Frequency devices 
used by participants. 

The ResponseCard RF Channel Slide displays instructions that 
show participants how to set the channel on their response 
devices. Setting channels prevents frequency disruption 
between response devices and receivers if simultaneous 
presentations are occurring in adjacent rooms. 

Before you change the channel settings on the ResponseCard 
devices, you will need to change the channel on the receiver. 
There are 82 possible channels for the ResponseCard RF and 
74 possible channels for ResponseCard XR, and the default 
channel is 41.



TurningPoint User Guide 65

Types of Slides

Once the channel is set correctly on the receiver, display the 
ResponseCard RF Channel Slide early in your presentation so 
that participants can update the channel code on their devices.

ResponseCard RF Channel Slide

vPad Log-In Slide The vPad Log-In slide displays setup information for 
participants using vPad to send their responses.

The vPad Log-In slide displays the computer’s friendly name, IP 
address, and port number, which are required for participants 
submitting responses using vPad. If some of the participants in 
your audience will be using vPad, you should include this slide 
early in your presentation so that they can successfully connect. 
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Find more information on using vPad in Chapter 4: Response 
Device and Settings Management. 

vPad Log-In Slide

Fill in the Blank Slide The Fill in the Blank slide contains a question region for you to 
pose a question. It does not contain an answer region or a chart, 
since the responses are in the form of text. ResponseCard IR, 
XL, and RF users are limited to numerical responses, but 
ResponseCard XR and vPad users may provide alphanumeric 
responses of varying lengths. 

You can specify one or more keywords in the TurningPoint 
settings that the answer should contain to be considered correct 
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(for reporting and grading purposes). Find more information in 
Chapter 4: Response Device and Settings Management.

Fill in the Blank Slide

Essay Slide The Essay slide contains a question region for you to pose a 
question. It does not contain an answer region or a chart, since 
the responses are in the form of text. ResponseCard IR, XL, and 
RF users are limited to numerical responses, but 
ResponseCard XR and vPad users may provide alphanumeric 
responses of varying lengths. 

Essay Slide
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Modify Slides

TurningPoint slides are simply ordinary PowerPoint slides with extra features, so you can use and 
customize them as you would an ordinary PowerPoint slide. You can reorder slides, move objects, 
add text and pictures, apply fonts and color schemes, and use animation. Find more information in 
your PowerPoint documentation.

You can also modify the features TurningPoint adds to your slides. You can change chart types and 
colors. Find more information in Chart Slides on page 57. You can use pictures for answers. Find 
more information in Create Picture Slides on page 78. And you can add a Correct Answer Indicator 
Find more information in Add a Correct Answer Indicator on page 88.

This section describes how to: 

• Designate a Demographic Slide

• Change Chart Types

• Identify a Correct Answer

• Set Point Values

• Clear Answer Values

• Create Picture Slides

• Change Chart Colors

• Make a PowerPoint Slide Interactive by Inserting a Chart

Designate a Demographic Slide

You can designate a slide as demographic to see how a certain group in your audience responds to 
certain questions. Slides designated as Demographic can be used in conjunction with Demographic 
Reports. Find more information on Demographic Reports on page 219.

Note Chart settings will retain any modifications 
you make, even after you add or remove 
answers on the modified chart slides.
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Step by Step Instructions To designate a slide as ‘Demographic’...

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window

2 Select the slide you want to 
designate as Demographic 
from the Settings Hierarchy.

The available settings for the slide display in the right pane of 
the window. 
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3 Select Demographic 
Question.

A Drop-down menu opens.

Settings for Demographic Slide

4 Select True. Your slide is now a Demographic slide.

Change Chart Types

You can change the type of chart on a TurningPoint slide using the Insert Object menu.

Step by Step Instructions To change a chart’s type…

1 Navigate to the TurningPoint 
slide in your presentation on 
which you would like to 
change the chart.
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2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

Insert Object Menu

3 Select Charts to display the 
Charts submenu.

Insert Object: Chart Selection

4 Select the type of chart you 
would like to appear on the 
slide.

When you select the chart type, TurningPoint changes the chart 
on your slide to match the type.
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Identify a Correct Answer

You can specify whether answers in your TurningPoint slides should be considered correct or 
incorrect from the Settings window. By setting answer values, you can show the correct answer after 
polling with a Correct Answer Indicator. Find more information in Add a Correct Answer Indicator on 
page 88.

You can identify a correct answer to a question from the Settings window. By default, answers marked 
Correct have a point value of 100 points, and answers marked Incorrect have a point value of 0 points 
for the purposes of scoring and competition. Find information about assigning specific point values to 
answers in Set Point Values on page 74.

Step by Step Instructions To mark an answer correct from the Settings window…

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window

2 From the Settings Hierarchy, 
select the slide on which you 
would like to identify a correct 
answer.
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3 Select the Answer you want 
to identify as correct.

The settings for that answer display in the right pane of the 
window.

Settings Window: Answer Settings

4 Select Correct from the 
Answer Value drop-down 
menu.

Settings Window: Select Correct

TurningPoint sets the selected answer as Correct and 
automatically sets all other answers on that slide as Incorrect.

You can have more than one correct answer on a slide by 
repeating these steps on another answer.
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You can change an answer you marked as Correct to Incorrect 
by repeating these steps and selecting Incorrect from the drop-
down menu.

Set Point Values

The answer values are used in generating graded reports, scoring reports and others available in 
Turning Reports. Find more information in Reports on page 211.

You can set the point value for an answer in the range of  0 through 10,000. An answer set as Correct 
has a default point value of 100. An incorrect answer has a default point value of 0. 

You can assign different point values to different answers (if one answer should be awarded more 
than another, for example).

Conversely, you can enable participants to receive negative points for correct answers in the same 
way. 

You can identify a correct or incorrect answer by following the instructions in Identify a Correct 
Answer on page 72. 
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Step by Step Instructions To set a point value for an answer…

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window

2 From the Settings Hierarchy, 
select the answer to which 
you would like to assign a a 
point value. 

The available settings for the answer display in the right pane of 
the window. 

Answer Settings
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3 Double-click in the Answer 
Value drop-down menu.

The current value is highlighted. 

Answer Value

4 Enter a point value. You can enter a point value ranging form zero through 10,000.

5 Press the Enter Key. TurningPoint sets the point value for the selected answer.

You can set the point value for another answer by repeating 
these steps on another answer.

You can change the point value you set by repeating these 
steps on the same answer and entering the new point value 
instead.

You can clear the point value for a particular answer on a slide 
or all answers in a presentation by following the instructions in 
Clear Answer Values on page 76. 

Clear Answer Values 

You can clear the value from an answer.
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Step by Step Instructions To clear the answer values for a presentation…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The settings window open

2 From the Settings Hierarchy, 
select the answer for which 
you would like to clear the 
answer value. 

The available settings for the answer display in the right pane of 
the window.

Answer Settings
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3 Select No Value from the 
Answer Value drop-down 
menu.

TurningPoint clears the answer value for the selected answer. 

Answer Value

Alternatively, select the Reset All Settings button to reset all of 
the answer values in the presentation. If you choose this option, 
TurningPoint resets all of the settings back to their default 
settings.

Find information for setting Correct or Incorrect values in 
Identify a Correct Answer on page 72.

Find information for setting point values in Set Point Values on 
page 74.

Create Picture Slides

Instead of using textual answers in the answer region, you can use pictures. This is useful if you pose 
a question with visual responses or where a visual aid will help the audience choose.
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Step by Step Instructions To create a picture slide…

1 Create a TurningPoint slide. The text in the answer region will be replaced by pictures. 
Therefore, it is recommended that you use descriptive words or 
phrases for the answer text in the answer region because this 
text will still be used for the chart labels (answer aliases) and 
answer text in settings and reports. 

Find more information on creating a slide in Insert a Slide on 
page 51.

2 Insert pictures to use as 
answers using the options in 
PowerPoint’s Insert > Picture 
menu.

Insert one picture for each answer.

Find more information on inserting pictures in PowerPoint’s 
online help.

3 Resize and arrange the 
pictures the way you want 
them to appear on the slide.

Select and drag the picture to reposition it. Resize the picture 
using the Format Picture Command. Find more information in 
PowerPoint’s online help.

4 To order the pictures 
correctly with the answers, 
follow these steps:

a Ensure that no objects on 
the slide are selected by 
clicking outside the slide.

b Select the picture that 
corresponds to the first 
answer by clicking on it.

You can tell that the picture is selected when the resize 
handles are shown on its sides and corners.

Note Since you will be using pictures as answers, 
the horizontal and offset charts will not align 
correctly with the answers. Use a vertical, 3D 
pie, or distributed pie chart. Find more 
information in Types of Slides on page 56.
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c Select the picture that 
corresponds to the second 
answer by holding the Shift 
key on your keyboard and 
clicking on the picture.

Now both the first and second picture are selected.

d Repeat step c for each 
additional picture until you 
have selected one for each 
answer.

5 Select the Convert to Picture 
Slide button from the 
TurningPoint toolbar. 

Convert Picture Slide Button

When you select the Convert to Picture Slide button, the answer 
region is hidden and the pictures are enumerated with a label, 
according to the answers you assigned them.

Picture Slide

After you convert the answers to pictures, you can resize and 
arrange the pictures if you need to adjust them.

Note You may include pictures on your slide that 
are not associated with one of the answers 
(for decoration or illustration). Do not select 
these pictures.
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Additionally, you can identify a correct answer or set point 
values. Find more information in Identify a Correct Answer on 
page 72and Set Point Values on page 74.
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Change Chart Colors
TurningPoint slides display in the same color scheme as your PowerPoint presentation. See 
PowerPoint help for more information on changing chart colors.

Make a PowerPoint Slide Interactive by Inserting a Chart

You can make an ordinary PowerPoint slide interactive by adding a chart to a slide that already has a 
question and a list of answers, or by creating a PowerPoint slide with a title and a bulleted or 
numbered list. 

When you convert the slide to a TurningPoint slide using the following instructions, the title will 
become the question and the bulleted or numbered list will become the list of answers. You can 
include up to ten items in the list. The question/title and the list of answers/numbered list must be in 
two separate boxes in order for the conversion to work properly.

Step by Step Instructions To convert a PowerPoint slide to an interactive slide…

1 Navigate to the PowerPoint 
slide in your presentation that 
you would like to convert to a 
TurningPoint slide.
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2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

Insert Object Menu

3 Select Charts. A submenu opens and displays the list of available charts.

Insert Object: Chart Selection

4 Select a chart to add to the 
slide.

When you select the chart to be added, TurningPoint converts 
the title of your slide to the question, the bulleted or numbered 
list to the answers, and adds the chart to the slide. 

You now have a functioning TurningPoint slide.

Find more information on chart types in Chart Slides on 
page 57.
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Add Objects

TurningPoint offers several static and interactive objects you can add to your slides: Answer Now 
prompts, Countdowns,  Correct Answer Indicators, Text Message prompts and Statistics Indicators. 

Insert Object Menu

This section describes how to:

• Add an Answer Now Indicator 

• Add a Countdown Indicator

• Add a Correct Answer Indicator

• Add Text Messaging

• Add Statistics Indicators

Add an Answer Now Indicator

An Answer Now Indicator gives the audience a visual cue that the slide is a TurningPoint slide to 
which they have the opportunity to respond. An Answer Now Indicator appears during a presentation 
when polling opens and disappears when polling is closed. 



TurningPoint User Guide 85

Add Objects

There are two Answer Now Indicators to choose from.

Answer Now Indicators

The Answer Now Indicator can be moved and resized like an ordinary PowerPoint object. You can 
change the text “Answer Now” by selecting the text to edit it.

Step by Step Instructions To add an Answer Now Indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add 
an Answer Now Indicator.

2 From the TurningPoint 
toolbar, select Insert Object.

The Insert Object menu opens.

Insert Object Menu

 Bevel  Prompt
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3 Select Answer Now. A submenu opens displaying the available Answer Now 
Indicators.

Answer Now Submenu

4 Select an Answer Now 
Indicator.

TurningPoint places the Answer Now Indicator on your slide.

You can move, resize, or change the text of the Answer Now 
Indicator to better fit your slide. You can also delete the Answer 
Now Indicator if you no longer want it to appear on the slide.

To replace an existing Answer Now Indicator with a different 
type, simply repeat these steps. The current Answer Now 
Indicator will be replaced with the new one you select.

Add a Countdown Indicator

A Countdown Indicator gives the audience a visual cue that polling for a question is about to close. 
The Countdown Indicator shows the number of seconds remaining and counts down to zero. A 
countdown can have a maximum length of 999 seconds. The indicator appears during a presentation 
when you advance the slide during polling. When the countdown expires, the Countdown Indicator 
disappears and polling is automatically closed.
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You can specify that a Countdown Indicator should appear automatically on each TurningPoint slide 
that you create using the Countdown setting, a presentation-level setting. Find more information 
about modifying settings in Response Device and Settings Management on page 97.

Countdown Indicator

Step by Step Instructions To add a Countdown Indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add 
an Countdown Indicator.

2 From the TurningPoint 
toolbar, select Insert Object.

The Insert Object menu opens.

Insert Object Menu
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3 Select Countdown. A submenu opens displaying the Countdown indicator.

Countdown Indicator Submenu

4 Select the Countdown 
Indicator.

TurningPoint places the Countdown Indicator on your slide.

You can move or resize the Countdown Indicator to better fit 
your slide. You can also delete the Countdown Indicator if you 
no longer want it to appear on the slide.

Add a Correct Answer Indicator

A Correct Answer Indicator gives a visual cue to the audience to indicate the correct answer(s) after 
polling for a question is finished. A Correct Answer Indicator appears during a presentation when you 
advance the slide after displaying the chart.

Note You can also change the length of the 
countdown by pressing control + click (or 
right click on the mouse) and selecting 
Change Timer Limit from the contextual 
menu. A dialog box opens prompting you to 
‘enter a value 1-999 for the Countdown time 
limit.’



TurningPoint User Guide 89

Add Objects

A Correct Answer indicator appears for each answer marked as Correct or for which a point value is 
specified. Find more information in Identify a Correct Answer on page 72 or Set Point Values on 
page 74.

Correct Answer Indicator

Step by Step Instructions To add a Correct Answer Indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Correct Answer Indicator.

2 From the TurningPoint 
toolbar, select Insert Object.

The Insert Object menu opens.

Insert Object Menu

 Checkmark  Star
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3 Select Correct Answer 
Indicator.

A submenu opens displaying the list of available Correct 
Answer Indicators.

Correct Answer Submenu

4 Select a Correct Answer. TurningPoint places the Correct Answer Indicator on your slide.

You can delete the Correct Answer Indicator if you no longer 
want it to appear on the slide.

To replace an existing Correct Answer Indicator with a different 
type, simply repeat these steps. The current Correct Answer 
Indicator will be replaced with the new one you select.

Add Text Messaging

Text Messaging allows you to send messages to vPad users to reinforce the content and their 
participation.

 A Text Message appears as a small object on your slide, but when it is shown, it automatically sends 
a message that can be viewed on a vPad.
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You can add more than one text message to a slide. For example, you might add a “Respond Now” 
message to send when polling opens and a “Time Is Up” message to send when polling closes. 

Step by Step Instructions To add a Text Message…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Text Message.

2 From the TurningPoint 
toolbar, select Insert Object.

The Insert Object menu opens.

Insert Object Menu

Tip Since Text Messages are objects on your slide, 
you can use PowerPoint’s animation features 
to time when they should be displayed. Find 
more information in PowerPoint’s online help.
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3 Select Text Message. A dialog box opens.

Text Message Dialog Box

4 Enter your message in the 
dialog box and select the OK 
button.

A speech balloon displays in the upper left corner of the slide. 
When TurningPoint is running the presentation session, this 
symbol notifies the participants in the audience to check their 
vPads for a text message. 

Slide with Text Message

You may now alter the timing of the message using 
PowerPoint’s animation features. By default, the message is 
sent as soon as the slide is shown, Find more information in 
PowerPoint’s help file.
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You can delete the Text Message object from the slide if you no 
longer want it to be sent. To add an additional Text Message, 
simply repeat these steps.

Add Statistics Indicators

Statistics Indicators allow you to reveal statistics about the responses after polling is closed.

Statistics Indicators show a calculation after polling is closed based on the responses received. You 
can show the mean (average), median, standard deviation, and variance of the responses. The value 
of the statistic is revealed when the chart is displayed.

Statistics Indicators

Statistics are calculated based on the numerical value of the response (the number of the answer on 
the slide). Since the statistics are based on the number of answers, they are most useful for questions 
with an ordered scale of answers (such as a Likert scale).

Step by Step Instructions To add a Statistic Indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Statistic Indicator.
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2 From the TurningPoint 
toolbar, select Insert Object.

The Insert Object menu opens.

Insert Object Menu

3 Select Stats. A submenu opens displaying the available Statistic Indicators.

Statistics Submenu

4 Select a Statistic Indicator. TurningPoint places the Statistic Indicator on your slide.

You can move or resize the Statistic Indicator to make it better 
fit your slide. You can delete the Statistic Indicator if you no 
longer want it to appear on the slide.
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You can add additional Statistic Indicators to the same slide (up 
to all four types). Simply repeat these steps and select the 
additional Statistic Indicator you would like to place on the slide.



96 Turning Technologies

Chapter 3: Creating and Saving Slides

Where Do I Go From Here?

This chapter has demonstrated how to create and customize TurningPoint slides for your 
presentation.

The next step in successfully using TurningPoint for an interactive presentation is to set up the 
hardware devices for participants to respond. Chapter 4: Response Device and Settings 
Management demonstrates this process. You only need to install the hardware devices one time on 
the computer you will use them with, unless you add or change the hardware devices.

If you have already installed hardware devices, the next step is to create a Participant List to keep 
track of the participants for your presentation. Chapter 5: Track Participants demonstrates this 
process.

If you already have a Participant List for the audience you will be presenting to, you are ready to 
conduct your presentation! Chapter 7: Run Presentations demonstrates this process.
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Response Device 
and Settings 
Management

This chapter discusses the installation and management of the Response Devices available for use 
by your audience. Additionally, this chapter describes the various settings available for customizing 
your presentation.
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Your audience responds to your interactive presentation using a response device. You can license 
response devices from Turning Technologies for use with TurningPoint. These response devices 
include:

Response Device Description

Responsive Innovations’ 
ResponseCard IR—a compact 
response device that uses infrared 
technology to send audience 
responses.

Responsive Innovations’ 
ResponseCard XL—a compact 
response device that uses infrared 
technology to send audience 
responses and allows for self-paced 
testing by letting students enter 
responses to many different 
questions on the card’s LCD then 
transmitting all the answers at once.

Responsive Innovations’ 
ResponseCard RF—a compact 
response device that uses radio 
frequency technology to send 
audience responses.
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TurningPoint also offers many settings you can use to customize the way your slides look and 
behave. You may notice that sections throughout this user guide mention settings that can have an 
effect on the tasks you perform with TurningPoint. 

Responsive Innovations’ 
ResponseCard XR —a compact 
response device that uses radio 
frequency technology to send 
audience responses and allows for 
self-paced testing by letting 
students enter responses to many 
different questions on the card’s 
multi-line LCD; then transmitting all 
the answers at once.

Turning Technologies’ vPad—a 
virtual keypad, installed on a 
personal computer, or Smart 
Devices, that takes advantage of a 
classroom network to send 
responses or control presentations. 

Response Device Description
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Recall the five steps to presentation success:

Five Steps to Success

This chapter covers the second step, connecting response devices with TurningPoint’s plug and play 
capabilities and managing your settings. 
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Install Devices

Users interact with your TurningPoint presentation using response devices that communicate through 
a response device receiver, or over a network or the internet. 

Response device receivers are connected directly to the computer that will be used to run the 
TurningPoint interactive presenation.This section includes instructions to install the device receivers.

The vPad response device software application allows users to participate with your presentation 
through an internal network. The vPad allows participants to respond to and provide feedback about 
your presentation. This section includes instructions to install the vPad software. 

This section describes how to:

• Install Infrared Response Device Receiver

• Install Radio Frequency Response Device Receiver

• Install the vPad Response Software

Install Infrared Response Device Receiver

The ResponseCards IR and XL communicate with TurningPoint using infrared technology. The 
receiver accepts the signal produced by the individual ResponseCards and passes the response 
along to TurningPoint.

Infrared Response Card and Receiver
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Before You Begin

The receiver must be installed on the machine that will be used to run the presentation.

Step by Step Instructions To install the infrared response device receiver…

1 Connect the device receiver 
to the USB port of the 
presentation computer.

Connect the USB Response Device Receiver to your computer.  
The device is now ready for use.

Infrared Response Device Receiver

2 Place the receiver in an 
unobstructed area at the front 
of the room.

The receiver operates on a “line of sight” and needs to be 
positioned so that it can receive the signal from the response 
devices. You may want to elevate the receiver so that it can be 
seen by everyone in the room.

Next Steps

Go to Response Device Management on page 114 to manage the settings for the response devices. 

The use of a Response Grid will help to alert you of a non-communicating Infrared response device. 
Find more information in View Polling Status on page 201.

Note The effective range of an infrared device 
receiver is about 90 feet (27meters). You will 
need to install one receiver for every 80 
participants.
Use more than one receiver during your 
presentation if your room size or participant 
size exceeds these maximum specifications. 
Contact Turning Technologies for suggested 
receiver layout plans.



TurningPoint User Guide 103

Install Devices

Step by Step Instructions To Check Device Communication…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens. 

2 Select Polling Test. TurningPoint opens the Polling Test window. Use this window to 
verify that TurningPoint can receive responses from the 
devices.

Settings Window: Polling Test

3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. 
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4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, and the key entry from 
each response device in the order in which they were tested. 

Polling Test: Response Device Test

5 Select the End Test button. TurningPoint ends Polling test.  

6 Close the Settings window. The device communication check is now complete. 
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Install Radio Frequency Response Device Receiver

The ResponseCards RF and XR communicate with TurningPoint using a radio frequency. The 
receiver accepts the signal produced by the individual ResponseCards and passes the response 
along to TurningPoint.

Radio Frequency Response Card and Receiver

Before You Begin

The receiver must be installed on the machine that will be used to run the presentation.
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Step by Step Instructions To install the radio frequency response device receiver…

1 Connect the device receiver 
to the USB port of the 
presentation computer.

Connect the USB Response Device Receiver to your computer.  
The device is now ready for use.

Radio Frequency Response Device Receiver

Next Steps

Go to Response Device Management on page 114 to manage the settings for the response devices. 

If an audience member’s device is not being accepted, check the device’s ability to communicate. 
Radio Frequency response devices provide on-screen confirmation that responses have been 
received. 

Step by Step Instructions To Check Device Communication…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens. 

Note The effective range of a Legacy RF Receiver is 
about 200 feet (60 meters) and the Long 
Range Receiver is about 400 feet (120 
meters). A single receiver is sufficient for up to 
1000 ResponseCards, and a direct line of sight 
between the receiver and the ResponseCard is 
not necessary.
Use more than one receiver during your 
presentation if your room size or participant 
size exceeds these maximum specifications. 
Contact Turning Technologies for suggested 
receiver layout plans.
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2 Select Polling Test. TurningPoint opens the Polling Test window. Use this window 
verify that TurningPoint can receive responses from the 
devices.

Settings Window: Polling Test

3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. 
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4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, and the key entry from 
each response device in the order in which they were tested. 

Polling Test: Response Device Test

5 Select the End Test button. TurningPoint ends Polling test. 

6 Close the Settings window. The device communication check is now complete. 

Install the vPad Response Software

The vPad group response software acts as a virtual response device. Audience members use the 
software from desktop or laptop computers or Smart Devices that are connected to the presentation 
computer using a wired or wireless network.
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vPads exhibit the same response behavior as ResponseCards. If you are running a vPad and connect 
during a presentation, you can close and reopen the vPad and still have the same response Device 
ID.

vPad Response Device

Before You Begin

TurningPoint must be installed on computers that use the same network.

Step by Step Instructions To install and set up the vPad software on a PC…

1 Insert the vPad installation 
CD into your computer’s CD-
ROM drive.

2 Run the vPad setup program. Follow the instructions in the vPad setup to install vPad on your 
desktop or laptop computer. The installation creates a vPad 
entry in your computer’s Applications menu.
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3 Double click on the vPad icon 
to start the vPad software.

The Turning vPad window opens.

vPad Response Device

You need to configure vPad to enable it to communicate on the 
network.

4 On the Turning vPad window, 
select Connection > Host.

The Select a Host Computer window opens.

vPad: Select A Host Computer
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5 Select the Plus button. The Turning vPad dialog box displays the friendly name setup 
and port number prompts.

vPad: Enter Friendly Computer Name/Port Number

6 In the Turning vPad window, 
enter the computer’s friendly 
name and Port number and 
select Save.

vPad adds the Host computer to the list of Host computers.

vPad: Host Computer List

7 In the Host Computer list, 
select Connect.

Turning vPad displays dialog box while attempting to connect 
and another dialog box when connection is successful. 
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8 Repeat steps 1 to 7 for each 
computer to be used as a 
response device.

Next Steps

Go to Response Device Management on page 114 to manage the settings for the response devices. 

If an audience member’s device is not being accepted, check the device’s ability to communicate. 
vPad response devices provide on-screen confirmation that responses have been received. 

Step by Step Instructions To Check Device Communication…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens. 

2 Select Polling Test. TurningPoint displays the Polling Test window. Use this window 
to verify that TurningPoint can receive responses from the 
devices.

Settings Window: Polling Test

3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. 
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4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, and the key entry from 
each response device in the order in which they were tested. 

Polling Test: Response Device Test

5 Select the End Test button. TurningPoint ends Polling test.  

6 Close the Settings window. The device communication check is now complete. 
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Response Device Management

Each audience participant uses a device to respond to the questions asked during the presentation. 
TurningPoint supports a variety of response devices including infrared and radio frequency 
ResponseCards as well as networked laptop and desktop computers and Smart Devices.

TurningPoint needs to know what types of response devices will be used before you run the 
presentation. Access the Response Device settings to confirm TurningPoint is configured to your 
needs. 

You may need to confirm your settings when you add new response devices and change the number 
of response devices to be used during a presentation session.

Additionally, you are able to test communication between TurningPoint and the response devices 
using the Polling Test found in settings.

This section describes how to:

• Add or Update Response Device Receivers

• Enable vPad

• Check Device Communication

• Identify the Number of Devices to be Used

Add or Update Response Device Receivers 

You may need to access the Response Device settings when you change the response device 
receivers. 

Before You Begin

You must have TurningPoint installed on the computer to be used for the presentations and response 
device receiver and ResponseCards at hand. 
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Step by Step Instructions

1 Connect the device receiver 
to the USB port of the 
presentation computer.

Connect the USB Response Device Receiver to your computer.  
The device is now ready for use. 

Next Steps

If an audience member’s device is not being accepted, check the device’s ability to communicate. 
Find more information in Check Device Communication on page 118. Radio Frequency response 
devices provide on-screen confirmation that responses have been received. For infrared response 
devices, the use of a Response Grid will help to alert you of a non-communicating device. Find more 
information in View Polling Status on page 201.

Enable vPad

Use the Response Device settings to enable vPad use with TurningPoint. 

Before You Begin

You must have TurningPoint installed on the computer to be used for the presentations and vPad 
installed on the computer to be used by participants.
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Step by Step Instructions To manage the response devices…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens. 

Settings Window

2 Select the Settings tab. 

3 Select Response Devices 
from the Settings Hierarchy.

The available response device settings display in the right pane 
of the window.
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4 Enable the vPad.

a Find Enable vPad under 
the vPad settings.

b Select Enable vPad. A drop-down menu opens. 

Settings Window: vPad Settings

c Select True. TurningPoint enables the vPad.

5 Close the Settings window. Your devices are ready for use with your interactive 
presentation.

Next Steps

If an audience member’s device is not being accepted, check the device’s ability to communicate. 
vPad response devices provide on-screen confirmation that responses have been received. 

Repeat this procedure when you need to change your vPad settings. Additionally, go to Identify the 
Number of Devices to be Used on page 120 when you need to make changes to the number of 
devices being used with your presentations.

Note TurningPoint uses True as the default setting 
for Enable vPad.
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Check Device Communication

You should test the communication between a device and TurningPoint if an audience member’s 
response is not being accepted during a live presentation. Radio Frequency and vPad response 
devices provide on-screen confirmation that responses have been received. For infrared response 
devices, the use of a Response Grid will help to alert you of a non-communicating device. Find more 
information in View Polling Status on page 201.

Before You Begin

Ensure the device receiver is properly installed and the device to be tested is available.

Step by Step Instructions To test for device communication…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens. 

Settings Window
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2 Select Polling Test. TurningPoint displays the Polling Test window. Use this window 
to verify that TurningPoint can receive responses from the 
devices.

Settings Window: Polling Test

3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. 
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4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, and the key entry from 
each response device in the order in which they were tested. 

Polling Test: Response Device Test

5 Select the End Test button. TurningPoint ends Polling test.  

6 Close the Settings window. The device communication check is now complete. 

Identify the Number of Devices to be Used

Access the Response Device settings whenever you need to change the number of expected 
devices. TurningPoint uses the number of expected devices when choosing Simulated Data.
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Step by Step Instructions To increase or decrease the expected devices…

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens. 

Settings Window

2 Select Response Devices 
from the Settings Hierarchy.

The available response device settings display in the right pane 
of the window. 
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3 Enter the number of expected 
response devices. 

a Find Expected Devices 
under the ResponseCard 
Misc settings.

Settings Window: Expected Devices

b Select Expected Devices. A text box opens. 

c Enter the number of 
expected devices.

d Press the Enter key.

4 Close the Settings Window. The expected number of response devices has been updated. 

Note You cannot exceed the number of licensed 
devices. For example, if you enter the number 
of expected devices as 60 in this region, but 
TurningPoint is licensed for 50 devices, only 50 
devices can be used during the presentation.
This does not apply to presenters with an 
unlimited license. They can use as many 
response devices as they choose.
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Next Steps

Optionally, test your response device communication by selecting the Polling Test tab from the 
Settings window. Find more information in Check Device Communication on page 118.
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 Settings

TurningPoint allows you to view and modify various settings from the Settings window. To access the 
Settings window select Tools from the TurningPoint toolbar and settings. 

Tools > Settings

You can adjust the settings in the Settings window:

Settings window

The Settings window contains two tabs: Settings and Polling Test. See Check Device 
Communication on page 118 for more information on Polling Test. 
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The Settings tab displays a Settings Hierarchy in the left pane of the window which allows you to 
change the settings for Application, Response Devices, Presentation, Slide or an Answer. The right 
pane of the window lists the settings. The settings are grouped by type and listed alphabetically. The 
name of each setting is in the left portion of the right pane and its value is on the right. Some settings 
may allow you to enter a value, while others will offer a drop-down menu to select from several 
choices.

At the bottom of the Settings window is a region that displays a detailed description of a setting when 
you select it. You can use these descriptions or the following pages to learn about the settings. 

Settings Window: Reset Settings

The Reset all Settings button allows you to return the settings back to the default installation state. 

The section describes:

• Application Settings

• Response Devices Settings

• Presentation Settings

• Slide Settings

• Answer Settings

The following sections contain information about the settings available by selecting the Settings tab 
and then selecting one of the following items from the Settings Hierarchy: Application, Response 
Device, Presentation, an individual slide or an answer. 
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Application Settings
Application contains settings that affect how TurningPoint functions. The list below contains detailed 
information for each setting.

Application Settings

Application Settings Allows you to view and change application settings.

Shortcut Keys Allows you to view and change various shortcut key settings. To 
change the default key strokes: 1.) Select the shortcut key to be 

Setting Description

File Location Determine the default location to 
save your sessions. The default 
setting is Documents. To change 
the location:1.) Select Change to 
open a dialog box. 2.) Choose a 
file location. 3.) Select Open.

To restore to the initial default 
location, click the Reset All 
Settings button. 



TurningPoint User Guide 127

Settings

changed. 2.) Select Change to open a dialog box. 3.) Select the 
new keystrokes. 4.) Select Save.

Setting Description

Start Slide Show Determines what keystrokes Start 
the TurningPoint Slide Show. 

Showbar Determines what keystrokes 
display and/or hide the Showbar 
during your interactive 
presentation. 

Open Polling Determines what keystrokes open 
polling and allow participants to 
provide responses to your 
interactive presentation. 

Close Polling Determines what keystrokes 
close polling and allow 
participants to provide responses 
to your interactive presentation.

Repoll The Current 
Slide

Determines what keystrokes clear 
the responses and enable you to 
accept new responses from the 
audience for the currently 
displayed question. Both the 
original responses and the new 
responses are stored in the 
session file. 

Response Grid Determines what keystrokes open 
a Response Grid on the screen 
and allow you to see which 
participants have responded to 
the question. 

Non-response Grid Determines what keystrokes open 
a Non-Response Grid on the 
screen. As each participant 
responds, their response box is 
removed from the grid. 

Participant Monitor Determines what keystrokes open 
the Participant Monitor. 



128 Turning Technologies

Chapter 4: Response Device and Settings Management

Feedback and 
Messaging

Determines what keystrokes 
opens and/or closes Feedback 
and Messaging. 

Toggle 
Percents/Counts

Determines what keystrokes 
change the values displayed on 
each chart. The values can be 
represented as either numbers or 
percents 

Setting Description
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Response Devices Settings
Response Devices contains settings for the response devices compatible with TurningPoint. The list 
below contains more detailed information for each setting.

Response Device Settings

ResponseCard Misc Allows you to view and change various response card settings.

Setting Description

Force Channel 
Change

Determines whether to force the 
Receiver Channel to change at 
the time of connection to the 
computer. The default is set at 
False and will force TurningPoint 
to accept the channel from the 
receiver. True will set the receiver 
to the first available slot in 
TurningPoint. 

Expected Devices Displays the number of Response 
Devices that you expect to be 
used during the presentation. 
This is only required when using 
Simulated Data.
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ResponseCard Channels Allows you to view the Response Receiver settings.

vPad Enables you to view and change various vPad settings.

Enforce Participant 
List

Determines whether only 
members of a Participant List can 
respond during a presentation or 
if anyone with a response device 
can respond. The default is set to 
True, which allows you to exclude 
the responses from participants 
who are not in the loaded 
Participant List. When set to 
false, all participants’ responses 
will be accepted and responses 
from participants who are not in 
the loaded Participant List will be 
appended to the end of that list. 

Overwrite User 
Information

Determines whether participant 
data received from a response 
device will overwrite the matching 
fields in the Participant List. The 
default is set to False, which will 
not overwrite the Participant List.

Setting Description

Setting Description

Receiver Displays Receiver ID and receiver 
Channels of the receivers 
connected to computer

Setting Description

Enable vPad Determines whether vPads can 
participate in the presentation 
remotely. The default is set to 
False and will not allow vPads to 
participate remotely.

Port Number Manually change the Port number 
that vPads use to participate in 
the presentation.

Name Displays the name of the 
presentation computer.
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Presentation Settings
Presentation contains settings for the creation of slides, the way they are displayed, and other 
TurningPoint options. If you change a presentation-level setting, the change applies to all slides you 
create in the future and in some cases in the currently opened presentation.

Presentation Settings

Response Reminders Settings Enables you to view and set the Response Reminders setting.

Correct Answer Indicators Enables you to view and change Correct Answer Indicator 
settings.

Setting Description

Countdown 
Seconds

Set the number of seconds a 
Countdown object will display. 
The acceptable range is 1-999. 
The default is set at 10 seconds.

Setting Description

Delay Determines the number of 
seconds between the end of 
polling and displaying the Correct 
Answer Indicator. The range can 
be from 0 to 20 seconds. The 
default is set at 4 seconds.
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Showbar Enables you to view and change Showbar settings.

Response/Non-Response
Grid Settings

Enables you to view and set the Response/Non-Response Grid 
Settings. To change Grid Colors: 1.) Select the current color to 
display the Color Select window. 2.) Select the new color. 3.) 
Close the window.

Setting Description

Use Second 
Monitor

Determines if the Showbar is 
displayed on the secondary 
monitor if available. The default is 
set to False, which does not 
display the Showbar on the 
secondary monitor.

Display Showbar Determines if the Showbar is 
visible during a SlideShow. The 
default is set to True, which 
displays the Showbar.

Expand Showbar Determines if the Showbar is 
displayed in its expanded state. 
The default is set to True, which 
displays the Showbar in its 
expanded state.

Setting Description

Auto Size Grid Determines whether the 
Response/Non-Response Grid 
will automatically resize to fit the 
screen. The default is set to True, 
which automatically resizes the 
Response/Non-Response Grid.

Maximum Grid 
Width

Determines the maximum width, 
in pixels, of the Response/Non-
Response Grid when the Auto 
Size Grid is set to False. The 
default size is set to 800.

Maximum Grid 
Height

Determines the maximum height, 
in pixels, of the Response/Non-
Response Grid when the Auto 
Size Grid is set to False. The 
default size is set to 600.
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Use Second 
Monitor

Determines if the grid is displayed 
on secondary monitor if available. 
The default is set to False, which 
does not display the Showbar on 
the secondary monitor.

Grid Rotation 
Interval

Determines the number of 
seconds a Response/Non-
Response Grid will pause 
between intervals. The 
acceptable range is 0.5 to 10 
seconds. The default is set at 2.

Display Participant 
Names

Determines if Participant names 
will be displayed in the 
Response/Non-Response Grid. 
The default is set to True, which 
will display the Participant Names

Cell Background 
Color 1

Determines the color that will be 
used for the Response/Non-
Response Grid’s cell 1st 
background color. 

Cell Background 
Color 2

Determines the color that will be 
used for the Response/Non-
Response Grid’s cell 2nd 
background color. 

Cell Background 
Color 3

Determines the color that will be 
used for the Response/Non-
Response Grid’s cell 3rd 
background color. 

Cell Background 
Color 4

Determines the color that will be 
used for the Response/Non-
Response Grid’s cell 4th 
background color. 

Grid Background 
Color

Determines the color that will be 
used for the Response/Non-
Response Grid background color. 

Grid Cell Text Color Determines the color of the text 
that will be used in the 
Response/Non-Response Grid. 

Gird Opacity Determines how transparent or 
opaque the Response/Non-
Response Grid is displayed. 
Move the slider to the right to 
increase opacity and to the left to 
decrease opacity.

Setting Description
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Slide Settings
Slide settings affect specific slides and answers. The slide settings apply to the slide selected from 
the Settings Hierarchy (and the particular answer, if applicable).

Slide Settings

Slide Settings Enables you to view and set Slide settings.

Setting Description

Demographic Determines if the question on the 
selected slide is treated as 
demographic question. The 
default is set to False, which does 
not treat the question as 
demographic.

Question Alias Determines how the question is 
labeled. This applies only to some 
reports. The default is set to how 
the question appears on the slide.
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Answer Settings
Answer-level settings affect specific answers. The answer settings apply to the answer selected from 
the Settings Hierarchy.

Answer Settings

Answer Settings This enables you to view and change the Answer settings.

Setting Description

Answer Alias Determines the Alias (Name) that is 
used for the chart labels and in 
some reports. The default is set to 
the answers entered during slide 
creation. 

Answer Value Determines whether the Answer is 
Correct, Incorrect, No Value, or has 
a point value of  zero through 
10,000. The default is set to No 
Value.
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Where Do I Go From Here?

If you are setting up your devices for the first time, the next step is to create your Participant List. A 
Participant List allows you to track the responses provided by your audience for each slide you 
present. Find instructions to create a Participant List in Chapter 5: Track Participants.

If you have installed new response device hardware, and you have already set up your Participant 
List, you can create a new interactive presentation or run an existing presentation using the new 
device. Find instructions to create slides in Chapter 3: Creating and Saving Slides. Find instructions 
to run a presentation in Chapter 7: Run Presentations.
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Participant Lists identify the members of your audience—your students, your trainees, your survey 
respondents—who will use a response device to respond to questions during your presentation. The 
participant name and other required information are stored along with the Device ID, a unique 
identifier for a response device. The Device ID is printed on the device tag, which is located on the 
back of the device (unless you are using vPad response software).
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Recall the five steps to presentation success. 

Five Steps to Success

This chapter discusses creating and managing a Participant List.



TestingPoint User Guide 139

Create Participant Lists

Create Participant Lists

Create a Participant List using the Participant List Assistant.

You may create multiple Participant Lists to be used with the same interactive presentation. One 
Participant List contains information about one audience group. Creating a multiple Participant Lists 
allows you to capture responses from multiple audiences to your slides.

• Create a Participant List Using Participant List Assistant

Create a Participant List Using Participant List  Assistant

The Participant List Assistant guides you through the creation of a Participant List to be used with 
your interactive presentation. You can control the number of responses TurningPoint will accept, 
which equates to the number of audience members by selecting to enforce a Participant List. A 
Participant List captures the audience names, their Device IDs, and other relevant information. Find 
more information about enforcing a Participant List in Response Device and Settings Management 
on page 97.

Create a Participant List using the Participant List Assistant. You can choose from using standard list 
templates or create one of your own to store as much information about your audience as is desired. 

Step by Step Instructions To create a Participant List…

1 From the TurningPoint 
toolbar, select Participants > 
Participant List Assistant.

Participants Menu
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The TurningPoint Participant List Assistant window opens 
presenting the option to use a pre-defined Participant List 
template or to create a custom template. Custom templates 
created in the past will appear in the Custom Templates region 
when the Custom Template button is selected.

2 Select a template to be used 
for the new Participant List.

Participant List Assistant

Participant List template choices include:

• Education—contains standard student information used 
for K–12 and higher education presentations, such as 
name and student ID.

• Corporate—contains entries for the information most 
often used in corporate feedback meetings including 
name, company name, telephone numbers, etc.

• All Fields—contains all information entries defined for use 
with TurningPoint.

• Blank—allows you to create a personalized Participant 
List and to name the template.
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• Custom—allows you to select a previously created 
template from the list.

3 Select the Continue button to 
continue.

TurningPoint displays the Participant List information entries 
(called fields). All entries that make up the template appear in 
the Selected Fields region on the right. Use this page to add, 
delete, or reorder the entries that make up the template.

Participant List: Add or Remove Fields

Tip Each of the templates can be customized. It 
may be faster to add and remove entries from 
a pre-defined template than to select Custom 
template and choose every entry.
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4 Optionally, customize the list 
of Selected Fields. 

• To remove an entry from 
the template, select it 
under the Selected Fields 
region and press the 
Delete key. 

When selecting entries from the fields lists, hold Shift + 
click to select multiple contiguous entries, or Command + 
click to select multiple entries. 

• To add an entry to the 
template, select the 
desired entry from the 
Available Fields region, 
and drag and drop the field 
into Selected Fields. 

• To change the order in 
Selected Fields, select the 
field and drag and drop it 
up or down the list. 

5 Select the Continue button to 
continue.

TurningPoint displays the Participant List summary page. 

Participant List Assistant: Summary

Note Alternatively, press the “-” button located at 
the bottom right of the window to delete the 
selected entry.

Note Alternatively, press the “+” button located at 
the bottom right of the window to add the 
select entry.
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6 Optionally, edit the 
Participant File composition.

You can change the Participant List file name by entering a new 
name over the old one. Select the Go Back button to add or 
delete a field.

7 Select the Finish button to 
create the Participant List 
and save it to a file.

TurningPoint displays the Participant Information window where 
you can type or edit data. You can also Add/Remove or Rename 
Fields and Groups from this window. Find more information on 
editing a Participant List in Modify a Participant List on 
page 145.

Participant List Assistant: Participant Information

8 Optionally, save the template 
for future use. 

If you have modified a pre-defined template or created a custom 
template, TurningPoint asks whether to save the settings as a 
custom template. If you select the Yes button to name and save 
the template, the custom template will be available under  
Templates in your Participant Folder when you create a 
Participant List.
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9 Add names and other 
participant information to the 
new Participant List. 

Participant Information

10 Select Save to save the data 
in the Participant List before 
closing the Participant 
Information window.

TurningPoint adds the new Participant List to TurningPoint 
toolbar in the Select a Participant List drop-down menu.

Next Steps

Find more information on editing and deleting your Participant Lists in Manage Participant Lists on 
page 145.
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Manage Participant Lists

After you have imported a Participant List or created one with the Participant List Assistant, you can 
make changes to a Participant List or delete it altogether.

This section describes how to:

• Modify a Participant List

• Delete a Participant List

Modify a Participant List

Follow these steps if you would like to make changes to an existing Participant List. Although the 
presenter’s computer assigns response Device IDs to each participant, you can change the recorded 
Device ID for a participant by modifying the list.

Before You Begin

A Participant List should have a.tpl extension (TurningPoint participants format). You must import the 
Participant List or create a list using the Participant List Assistant before editing it with TurningPoint. 

Step by Step Instructions To modify a Participant List…

1 From the TurningPoint 
toolbar, select Participants > 
Edit a Participant List.

Participants Menu
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TurningPoint displays a window of Participant Lists saved in 
Documents/TurningPoint/Participants.

2 Select the desired Participant 
List, and then select the 
Open button.

TurningPoint displays the Participant List data in the Participant 
Information window. The grey fields represent data that cannot 
be edited, such as the column titles and row numbers.

Participant Information window

3 Optionally, edit the existing 
data in the white fields by 
selecting the entries and 
typing new information.

4 Optionally, Add a Field. 

a Select a column in the 
Participant Information 
window.

TurningPoint inserts the new field after the last column. 
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b Select the down arrow at 
the bottom of the window. 

Participant Information: Edit

A menu opens listing the available editing options. 

c Select Add Field. An Add Participant Information window opens.

Participant Information: Add Participant Information

d Type the name of the new 
field in the space provided 
or select a field from the 
drop-down menu.

e Select Add. TurningPoint adds the field at the end of the list.
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f Repeat steps a through e 
to add additional fields.

5 Optionally, Rename a Field.

a Select the field  that you 
want to rename.

b Select the down arrow at 
the bottom of the window.

Participant Information: Edit Menu

TurningPoint displays the available editing options.
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c Select Rename Field. A text entry window opens. 

Participant Information: Field Entry

d Enter the new name of the 
field or select a field form 
the drop-down menu.

e Select Change. TurningPoint renames the selected field.
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6 Optionally, Remove a Field.

a Select the Field that you 
want to remove.

b Select the down arrow at 
the bottom of the window.

Participant Information: Edit Menu

TurningPoint displays the available editing options.

c Select Delete Field. TurningPoint deletes the selected field.
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7 Optionally, rearrange the 
column order in your 
Participant List.

a Select the column you 
would like to be moved. 

b Drag and drop the column 
in its new location.

8 Select File > Save. A confirmation message displays. 

Delete a Participant List

This section describes how to remove a Participant List from TurningPoint.

Before You Begin

Deleting a Participant List sends the file to the computer’s Trash. Save a backup copy in another 
location if you would like to be able to access the file later.
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Step by Step Instructions To delete a Participant List… 

1 From the TurningPoint 
toolbar, select Participants > 
Delete a Participant List.

Participants Menu

TurningPoint displays a window listing all Participant Lists.

2 Select the file name of the 
Participant List you wish to 
remove. 

Delete Participant List
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3 Click the Delete button. TurningPoint removes the file from the list.

Tip To retrieve a Participant List after deleting it, 
open the computer’s Trash, find the file and 
select it. Drag and drop the file from the Trash 
to a new location. If you choose to drag and 
drop the file to a new location, It will not be 
available to TurningPoint unless you import the 
file. 
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Where Do I Go From Here?

This chapter has demonstrated how to create and customize Participant Lists for your presentation.

If you have not set up the hardware devices for participants to respond, Chapter 4: Response Device 
and Settings Management demonstrates this process. You only need to set up hardware devices 
once on the computer you will use them with, unless you add or change the hardware devices.

If you have already set up hardware devices and have a Participant List for the audience you will be 
presenting to, you are ready to conduct your presentation! Chapter 7: Run Presentations 
demonstrates this process.
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TurningPoint offers tools that allow you to use powerful advanced features:

• Create and assign standards for evaluating participants

• Create slides aligned to state standards using QuestionPoint

• Create slides from imported files

The Standards tool enables you to use reports to evaluate the performance of participants based on 
standards. You can use the built-in standards or set up a list of standards and associate those 
standards with questions, and then evaluate the performance of the audience as a whole, by groups, 
or by individuals on each standard. Find more information in Standards on page 156. 

QuestionPoint allows you to access a question bank to create slides. Find more information in Create 
Slides from QuestionPoint on page 170.

The TurningPoint Parser allows you to automatically create presentations from XML or Word 
documents. Find more information in Import Slides with the TurningPoint Parser on page 184.

The Import from TestingPoint tool allows you to automatically create presentations from TestingPoint 
documents. Find more information in Import Slides from TestingPoint on page 186.
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Standards

TurningPoint’s standards tools allow you to use built-in standards (per state/country, type, subject and 
grade level) or to create your own lists of standards on which participants can be evaluated. For 
training, teaching, or testing, standards help you organize the material in your presentation into 
subject areas, competencies, or other standards which the participants should meet. You can then 
view participants’ results by standards using Turning Reports. Find more information in Reports on 
page 211.

Before you can assign standards to slides in a presentation, you need to select from the Built-in 
Standards or create a list of the standards you will be using.

This section describes how to:

• Create and Assign a Built-in Standards List

• Create a Custom Standards List

• Assign Custom Standards to Slides

Create and Assign a Built-in Standards List

TurningPoint 2008 comes loaded with built-in standards per state/country, topic, subject and grade 
level. Create a list of standards using any of these criteria.
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Step by Step Instructions To create a Built-in Standards List…

1 From the TurningPoint 
toolbar, select Tools.

The Tools menu opens.

Select Standards

2 Select Standards from the 
Tools menu.

The Standards window opens.

Standards Window
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3 Select Built-in Standards. A window opens and displays four drop-down menus: State…, 
Type…, Subject…, and Grade….

Standards Window

4 From the State… drop-down 
menu, select a state.

The Type… drop-down menu populates with topics for the 
selected state.

Built-in Standards: Select a State
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5 From the Type … drop-down 
menu, select a type.

The Subject… drop-down menu populates with subjects for the 
selected topic.

Built-in Standards: Select a Type

6 From the Subject… drop-
down menu, select a subject.

The Grade… drop-down menu populates with grade-levels for 
the selected subject.

Built-in Standards: Select a Subject
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7 From the Grade… drop-down 
menu, select a grade-level.

All of the standards for the selected state, type, subject, and 
grade-level display in the left pane of the Standards window.

Built-in Standards: Select a Grade

8 Drag and drop the standard 
to add it to the presentation or 
specific slide.

Standards Window: Standards for Presentation
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You can remove a standard by highlighting it and pressing the 
delete key on the keyboard.

9 Repeat these steps 
beginning with step 4 to add 
standards to additional 
slides.

Assign multiple standards or use multiple Standards Lists.

10 When you are finished 
assigning standards, select 
the Save button.

Create a Custom Standards List

TurningPoint allows you to create a list of standards to suit your specific needs. 

Note Alternatively, press the “-” button located at 
the bottom of the window to remove the 
selected standard. 
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Step by Step Instructions To create a Custom Standards List…

1 From the TurningPoint  
toolbar, select Tools.

The Tools menu opens.

Select Standards

2 Select Standards from the 
Tools menu.

The Standards window opens.

Standards window
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3 Select  Custom Standards 
Lists.

 A drop-down menu displays and allows you to choose from the 
Standards Lists in your Standards folder. Alternatively, select 
the Choose button to display the Standards Lists in your 
Standards folder. 

Custom Standards Window

4 Select the New button. TurningPoint places a new list under the Standards Pane of the 
Custom Standards window.

5 Optionally, double click on 
the name and enter a new 
name. 

TurningPoint displays the new Standards List in the left-hand 
pane of the Standards Window.

The new Standards List has a top-level category named <New>.

Note The standard is renamed when you save the 
standards list.
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6 To add a category or a 
standard, complete the 
following steps.

a Select the parent category 
in which to include the 
category or standard you 
wish you to add.

Categories arrange standards into a hierarchy.

Customs Standards: Select Parent Category
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b Select the Category or 
Standard from the 
selection box at the bottom 
of the Standards Window.

You can change the name by double clicking on the 
category or standard and entering a new name.

Custom Standards Window: Add Standard/Category

TurningPoint adds the category or standard to the parent 
category you selected.

c Repeat steps a and b until 
you have added all the 
categories and standards 
you require.

Select a category or standard from the list and select the 
Delete key to remove a category or standard from the list. 
Double click on a category or standard to change the 
name. 

7 When you are finished 
creating your Standards List, 
select the Save button.

TurningPoint indicates that you have made changes to the 
Standards List and asks if you would like to save your changes.

8 Select the Yes button. A Save As dialog displays and allows you to name the Standard 
List.

Note Alternatively, press the “-” button located at 
the bottom of the window to remove the 
selected category or standard. 
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9 Select Save. TurningPoint saves the changes to your Standards List file and 
the Standards window closes.

Next Steps

To associate standards with slides, follow the instructions in the next section, Assign Custom 
Standards to Slides.

Assign Custom Standards to Slides

Assigning a Custom Standards List to slides allows you to use TurningPoint  reports to assess 
participants’ performance on slides relating to the standards.

Before You Begin

You should create or obtain Standards Lists to be assigned to the slides. Find more information in 
Create a Custom Standards List on page 161.

Step by Step Instructions To assign standards to slides…

1 From the TurningPoint  
toolbar, select Tools.

The Tools menu opens.

Select Standards
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2 Select Standards from the 
Tools menu.

The Standards window opens displaying two options: Built-in 
Standards and Custom Standards.

Standards window

3 Select  Custom Standards 
Lists.

 A drop-down menu displays and allows you to choose from the 
Standards Lists in your Standards folder. Alternatively, select 
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the Choose button to display the Standards Lists in your 
Standards folder. 

Custom Standards Window

4 Select a Standards List in 
one of the following ways:

a Select a Standards List 
from the Standards folder 
using the drop-down 
menu.

The categories and standards are displayed in the left-
hand pane of the Standards window.

b Select a Standards List 
from elsewhere using the 
Choose button.

The categories and standards are displayed in the left-
hand pane of the Standards window.
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5 Drag and drop the standard 
to add it to the presentation or 
specific slide.

Standards Window: Standards for Presentation

You can remove a standard by highlighting it and pressing the 
delete key on the keyboard.

6 Repeat these steps 
beginning with step 5 to add 
standards to additional 
slides.

Assign multiple standards or use multiple Standards Lists.

7 When you are finished 
assigning standards, select 
the Save button.

Next Steps

Several reports allow you to assess participants’ performance on the standards you assigned. Find 
more information in Reports on page 211.

Note Alternatively, press the “-” button located at 
the bottom of the window to remove the 
selected standard. 
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QuestionPoint

QuestionPoint is a question bank of 30,000 assessment items aligned to state standards and sorted 
by grade and subject. This bank of questions enables teachers and administrators to easily generate 
assessments and create interactive presentations from those assessments.

This section describes how to:

• Create Slides from QuestionPoint

Create Slides from QuestionPoint

You can use the assessments found in QuestionPoint to create an interactive presentation. 
QuestionPoint has been integrated with TurningPoint  to provide a seamless connection between the 
two applications. Creating an interactive presentation is quick and easy. 

Step by Step Instructions To generate a presentation using QuestionPoint…

1 From the TurningPoint  
toolbar, select Tools. 

The Tools menu opens.

Select QuestionPoint
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2 Select QuestionPoint. The QuestionPoint window opens.

QuestionPoint

The window displays the Standards, Aligned Questions, and 
Selected Questions window panes and the State…, Type…, 
Subject…, and Grade…, drop-down menus.

3 From the State… drop-down 
menu, select a state on which 
to base your assessment.

QuestionPoint: Select a State
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The Type… drop-down menu populates with the types of 
standards available for the selected state.

4 Select a type of standard 
from the Type… drop-down 
menu.

QuestionPoint: Select a Type

The Subject… drop-down menu populates with the available 
subjects for the selected state.

5 Select a subject from the 
Subject… drop-down menu.

QuestionPoint: Select a Subject
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The Grade… drop-down menu populates with the available 
grade-levels for the selected state, type of standard, and 
subject. 

6 Select a grade-level from the 
Grade… drop-down menu.

QuestionPoint: Select a Grade-level

A list of standards displays in the Standards pane. The 
standards are based on the selected state, type of standard, 
subject, and grade-level.
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7 Select a standard from the list 
of standards.

A list of questions displays in the Aligned Questions pane.

QuestionPoint: Select a Standard

TurningPoint  highlights the correct answer for each question in 
green.

8 Select a question from the list 
and double click or drag and 
drop the question to the 
Selected Questions pane. 

QuestionPoint: Select a Question
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• Repeat steps 7 and 8 to 
add additional questions.

The selected question(s) display in the Selected 
Questions pane.

QuestionPoint: Questions Added

9 Select the Generate Slides 
button.

A dialog opens presenting two options: Slide Options and Slide 
Position. 

• Slide Options - Add a Correct Answer Indicator to the 
slides.

• Slide Position - Choose to add the slides to the end of the 
current presentation or create a new presentation.

Import Dialog
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10 Optionally, add a Correct 
Answer Indicator from the 
Correct Answer Indicator 
drop-down menu under Slide 
Options.

Choose from a Checkmark or Star.

Additionally, you can add or change a Correct Answer Indicator 
after you build the slides. Find more information in Add a 
Correct Answer Indicator on page 88.

11 Under Slide Position, select 
the Create a New 
Presentation button to create 
a new presentation, or Select 
Add to Active Presentation to 
add the slides to the current 
presentation.

You now have a fully functional TurningPoint presentation.

12 Save your presentation as a 
PowerPoint slide show.

Next Steps

Find information about running your TurningPoint  presentation in Run Presentations on page 191. 
Customize your slides by adding a variety of animated feedback mechanisms. Find information about 
these different presentation objects and a variety of other slide features in Creating and Saving 
Slides on page 47.
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Parser Documents

The TurningPoint Parser can import two kinds of documents:

• an XML document

• a Microsoft Word document (.doc)

To be imported by the TurningPoint Parser, these documents must be formatted in the proper way. 
The following sections describe the proper formats for documents imported by the Parser.

This section describes how to:

• Format XML Documents

• Format Word Documents
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Format XML Documents
The following is a basic shell of the XML document type accepted by the TurningPoint Parser:

<slides count=”” id=””>
<slide id=”” type=”” multiresponse=””>
<question alias=”” filename=””

imageposition=”” />
<topic id=””> 

</topic id>
<answers>
<answer alias=”” value=”” filename=”” />

</answers>
</slide>

</slides>

Each element is described below, along with an example and an explanation of the attributes.

slides The slides element is the top-level element in the XML 
document and contains all the information TurningPoint 
requires to create the interactive presentation. The slides 
element contains a number of slide elements.

<slides count=”1” id=”86FF9DB9”>
</slides>

Note Remember that the following characters are 
reserved in XML: < > & ‘ “
Use the XML entities for these characters 
(&lt; &gt; &amp; &apos; &quot; 
respectively).

Attribute Description

count The total number of slide elements in 
the presentation.

id An optional attribute that contains a 
unique identifier for the group of 
slides.
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slide Each slide element contains the question and answer 
information for a single slide.

<slide id=”E15F45B” type=”D” multiresponse=”1”>
</slides>

question The question element contains the question information (as 
attributes) and the question text (as content).

<question alias=”Gender?” filename=”” imageposition=””>
What is your gender?

</question>

Attribute Description

id An optional attribute that contains a 
unique identifier for the slide.

type Defines what type of slide to create 
using a single-letter code. The 
following types are accepted:

• Q = standard question slide
• P = picture slide
• F = fill in the blank slide 

(ResponseCard IR, XL, and RF 
users are limited to numerical 
responses, but ResponseCard XR 
and vPad users may provide 
alphanumeric responses of varying 
lengths)

• E = essay slide (ResponseCard IR, 
XL, and RF users are limited to 
numerical responses, but 
ResponseCard XR and vPad users 
may provide alphanumeric 
responses of varying lengths)

Attribute Description

alias An optional attribute that contains an 
alias for the question.
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topic The topic element contains the question topic.

<topic id=””></topic>

answers The answers element contains a number of answer elements.

<answers></answers>

answer Each answer element contains answer information (as 
attributes) and the answer text (as content) for a single answer.

<answer alias=”” value=”” filename=””>
Female

</answer>

filename An optional attribute that contains a 
filename for a picture that can be 
included with the question.

imageposition An optional attribute that sets the 
question picture position. The 
following are acceptable values:

• L = Left
• R = Right
• F = Full

Attribute Description

Attribute Description

id An optional attribute that contains a 
unique identifier for the topic.

Attribute Description

alias An optional attribute that contains an 
alias for the question.
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value An optional attribute that contains a 
value for the answer. Valid answer 
values are “Correct”, “Incorrect”, or a 
point value from zero through 10,000. 

filename An optional attribute that contains a 
filename for a picture that can be 
used in place of the answer text on 
the slide. This attribute is used only if 
the slide type attribute is set to “P”.

Attribute Description
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Format Word Documents
To create a Word document to be imported by the TurningPoint Parser, you must create an outline 
using the heading styles built into Word. You can apply the heading styles using the drop-down menu 
in the Formatting toolbar, or in the Styles and Formatting pane available through the Format menu.

Each question must use the “Heading 1” style. The question is followed by several answers on 
separate lines using the “Heading 2” style.

In addition to the question and answer text, you can use optional TurningPoint tags to control other 
settings. Each TurningPoint tag must use the “Heading 3” style. Tags occur at the start of the outline 
(for tags that apply to the entire presentation) or on the lines immediately following a question or 
answer (for tags that apply only to a specific question or answer). A tag is formatted in the following 
way:

<tag>value

All tags are optional. If omitted, the slide will default to a standard question slide.

The tags are described in the following table.

Tag Location Description and Allowed Values

<c> Start of 
outline.

The number of slides in the 
presentation.

<d> Start of 
outline or 
following a 
question.

Contains the Session ID (if at the 
start of the outline) or topic ID (if 
following a question).

<a> Following a 
question or 
an answer.

Contains an alias for a question or 
answer.
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<t> Following a 
question.

Defines what type of slide to create 
using a single-letter code. The 
following types are accepted:

• Q = standard question slide
• P = picture slide
• F = fill in the blank slide 

(ResponseCard IR, XL, and RF 
users are limited to numerical 
responses, but ResponseCard 
XR and vPad users may 
provide alphanumeric 
responses of varying lengths)

• E = essay slide (ResponseCard 
IR, XL, and RF users are limited 
to numerical responses, but 
ResponseCard XR and vPad 
users may provide 
alphanumeric responses of 
varying lengths)

<f> Following a 
question or 
an answer.

The filename of a picture file. If the 
tag follows a question, the picture 
will be added next to the question 
text on the slide. If the slide type is 
“P” and the tag follows an answer, 
the picture will replace the answer 
text on the slide.

<n> Following a 
question.

Contains the question picture 
position. The following are 
acceptable values:

• L = Left
• R = Right
• F = Full

<p> Following a 
question.

Contains the question topic. 

<v> Following 
an answer.

Contains a value for the answer. 
Valid answer values are “Correct”, 
“Incorrect”, or a point value from 
zero through 10,000. 

Tag Location Description and Allowed Values
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Import Slides

TurningPoint can automatically create TurningPoint slides from Microsoft Word files, XML files or 
TestingPoint.

Using this feature of TurningPoint provides a quick way to create a number of slides, and it is also 
beneficial if you already have question and answer data in another form that you would like to 
transform into TurningPoint slides.

A simple slide presentation can be created by importing a an XML document or Microsoft Word 
document using the TurningPoint Parser. Alternatively, you can import question and answer data from 
TestingPoint.

This section describes how to:

• Import Slides with the TurningPoint Parser

• Import Slides from TestingPoint

Import Slides with the TurningPoint Parser

The TurningPoint Parser is located in the Tools menu and allows you to automatically create slides 
from Microsoft Word or XML files. 
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Step by Step Instructions To import slides with the TurningPoint Parser…

1 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

Select TurningPoint Parser

2 Select TurningPoint Parser. A dialog window opens.

Open File Dialog
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3 Navigate to the file you would 
like to import (.xml and.doc) 
and select it.

4 Select the Open button to 
continue.

A dialog opens asking whether you would like to add the slides 
to the active presentation or create a new presentation.

5 Select the Yes button to add 
the slides to the active 
presentation, or select the No 
button to create a new 
presentation.

TurningPoint builds the slides from the file. If there are many 
slides, this may take some time.

Next Steps

The slides imported by the TurningPoint Parser are normal TurningPoint slides, so you can take 
advantage of any the TurningPoint customizations you would like to make on them.

Import Slides from TestingPoint

TurningPoint can insert files from TestingPoint and create slides based on them. TurningPoint retains 
the features used in the TestingPoint files.
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Step by Step Instructions To import slides from TestingPoint…

1 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

Select TestingPoint

2 Select Import from 
TestingPoint.

A dialog opens.

Open TestingPoint Document Dialog
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3 Navigate to the file you would 
like to import and select it.

4 Select the Open button to 
continue.

A dialog opens asking whether you would like to add the slides 
to the active presentation or create a new presentation.

5 Select the Yes button to add 
the slides to the active 
presentation, or select the No 
button to create a new 
presentation.

TurningPoint builds the slides from the file. If there are many 
slides, this may take some time.
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Where Do I Go From Here?

This chapter has demonstrated how to use tools with TurningPoint. After you create your TurningPoint 
slides, you are ready to run a presentation. 

Chapter 7: Run Presentations describes the process of running a presentation. 
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Run 
Presentations

After you have created the slides and objects discussed in Chapter 3: Creating and Saving Slides, 
you are ready to run an interactive presentation. The process of running a presentation requires a few 
preliminary steps and offers some options and tools that this chapter demonstrates for you.

Each time you run a presentation, TurningPoint creates a unique session. A session is made up of 
data pertaining to the response devices, the participants in the audience, and the responses of the 
participants. This data typically saves to the computer that is running the presentation. 

To run a presentation:

• Establish the settings for gathering and storing responses on the computer that runs the 
presentation. The settings are made up of the results data, which may need to be reset, the 
response devices, and the Participant List. Optionally, the settings could include preferences for 
the Response Grid, especially if infrared ResponseCards are used.

• Run a presentation session. A session is similar to running a typical PowerPoint slide show, but as 
you present, the Showbar is initially available at the top of the screen during interactive slides. The 
Showbar allows you to open and close polling, view polling status, and view the response data in 
a variety of ways. 

• Save a session. You can save the results of your interactive presentation and generate reports 
through TurningPoint to evaluate the audience’s responses. You will want to save the responses 
provided by your audience for each presentation session. 
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You can perform test runs or present the completed presentation to your audience. Behind the 
scenes, TurningPoint gathers, tallies, and stores the responses from your audience. 

Recall the five steps to presentation success. As depicted in the following diagram, running a 
presentation session is the fourth step when using TurningPoint.

Five Steps to Success

This chapter describes the following activities to help your presentation run smoothly:

• Run an interactive presentation using the Slide Show functionality. Find instructions for running a 
presentation in Run a Presentation on page 193.

• Control the presentation using the Showbar. Find instructions for using the Showbar in Run the 
Slide Show on page 197 and View Polling Status on page 201.

• Monitor the audience participation. Find instructions for monitoring in View Polling Status on 
page 201 and Use the Participant Monitor on page 203.
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Run a Presentation

You run an interactive presentation session using PowerPoint’s Slide Show functionality. 

You control the presentation session by opening and closing polling. Polling is the mechanism by 
which TurningPoint accepts and tallies the responses provided by the audience using response 
devices.

This section describes how to:

• Establish the Presentation Settings

• Run the Slide Show

• View Polling Status

• Use the Participant Monitor

• Add Slides During a Presentation Session

Establish the Presentation Settings

The presentation settings consist of the results data and Participant List to be used, which are 
important items to check before running the presentation.

Prior to starting a presentation session, you must perform the following steps: 

• Clear any previous session results.

• Identify the Participant List to be used.

This section explains how to perform these steps. It also demonstrates how to create the settings for 
the Response Grid, an option especially helpful to sessions with infrared ResponseCards, that gives 
participants confirmation that their responses were received.

Before You Begin

Chapter 4 discusses the response devices you set up before you begin. Find information on getting 
the response devices ready in Chapter 4: Response Device and Settings Management.
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If you are using ResponseCards or the vPad, you can use the Polling Test feature to test 
TurningPoint’s ability to successfully receive responses. Find information on Polling Test in Chapter 
4: Response Device and Settings Management. 

If you want to track responses, you must have also created a Participant List using the Participant List 
Assistant. Without a Participant List, the session collects anonymous responses and generates an 
automatic participant list. Find information on Participant Lists in Chapter 5: Track Participants.

Step by Step Instructions To create the settings for the presentation session…

1 From the PowerPoint Office 
button, select Open.

A window opens and displays the available files.

2 Select the TurningPoint 
presentation to be used, and 
select the Open button.

The file’s contents are visible in the PowerPoint window. You 
can use the TurningPoint toolbar to clear any previous results 
data and identify the use of response devices and a Participant 
List.

3 From the TurningPoint 
toolbar, select Reset > 
Session.

Reset Sessions

Prior to starting the presentation session, you must clear all 
prior audience responses that are stored in memory. 

If you select Reset > All Slides, new data is appended to the end 
of the session without resetting the entire session. If you select 
Reset > Current Slide, you remove values for the current slide 
without removing the data from the session.

TurningPoint displays a window instructing you to wait until all 
responses have been cleared before continuing with your slide 
show.
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4 Optionally, from the 
TurningPoint toolbar, select 
the Response Device menu 
and select an option for 
testing the presentation.

Response Device Selection

Response Devices is the default setting. TurningPoint allows 
you to select how responses will be provided during the 
presentation. Your choices are:

• Response Devices—a response device will be used 
during the presentation. The response device must have 
been set up as outlined in Chapter 4: Response Device 
and Settings Management.

• Simulated Data—TurningPoint provides random 
responses to the presentation. TurningPoint determines 
the number of responses to provide based on the number 
of expected devices designated in settings. i.e. If you 
enter expected devices as 100, TurningPoint will provide 
up to 100 responses to each question in your 
presentation. Find more information on expected devices 
in Enable vPad on page 115.

Note Always use the Response Devices default 
setting for an actual presentation. Select 
Simulated Data when testing a presentation.
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5 Optionally, from the 
TurningPoint toolbar, select 
Tools > Settings. In the 
window, select the 
Presentation from the 
Settings Hierarchy.

The TurningPoint Settings window opens.

Settings Window

Use these settings to establish the settings for the entire 
presentation. You can establish the settings for a specific slide 
or answer by selecting that slide or answer, respectively, from 
Settings Hierarchy. Find more information about modifying 
settings in Response Device and Settings Management on 
page 97. 

If infrared ResponseCards are used, it is recommended that you 
use a Response Grid, which gives participants confirmation that 
their responses are received. The Response Grid is 
unnecessary with radio frequency and vPad devices provide on-
screen confirmation that responses have been received. The 
following settings affect the presentation and style of the 
Response Grid that can be shown during an interactive slide 
show. 

Response Grid

Note A Response Grid is recommended for use 
with infrared ResponseCards to give 
participants confirmation that their responses 
are received. 
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These settings affect what is displayed in each box of the 
Response Grid. 

• Display Participant Names—select True to display the 
participant’s name in the Response Grid.

These settings affect how the Response Grid is displayed.

• Grid Opacity—use a slider to choose a percentage to 
identify how opaque the Response Grid should be when 
opened.

• Grid Rotation Interval—enter the number of seconds per 
interval the Response Grid takes to rotate through 
responses. This is needed when there are too many 
participants to fit in one grid.

• Maximum Grid Width—identifies how wide the Response 
Grid should be on the screen. The width is measured in 
pixels. The default setting is 800.

• Maximum Grid Height—identifies how wide the Response 
Grid should be on the screen. The height is measured in 
pixels. The default setting is 600.

Next Steps

After establishing the settings, you are now ready to run the presentation.

Run the Slide Show

Use PowerPoint’s Slide Show functionality to run your interactive presentation. TurningPoint accepts 
responses provided by your audience, presents the results of the responses, and stores the 
responses in memory. You either save the responses to a session file or clear the memory.
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Before You Begin

To run the slide show, you must first perform the steps listed under Establish Presentation Settings to 
create the settings for your presentation session.

Step by Step Instructions To run the interactive presentation…

1 From the TurningPoint 
Toolbar select Start a 
TurningPoint Slide Show. 

Start TurningPoint Slide Show

The first slide of the presentation is shown. TurningPoint 
displays the Showbar in the top right corner of the screen. The 
Showbar is a toolbar that provides activation buttons for polling, 
monitoring, and viewing responses during the slide show.

Showbar

Move your cursor across the Showbar to display each 
command’s name. To activate the command, you can select the 
Showbar icon or use the respective short cut keys on your 
keyboard. Use the commands on the Showbar as follows:

Show/Hide 
Showbar

Closes the Showbar for the 
duration of the current 
presentation session.

Open Polling Opens polling and allows 
participants to provide 
responses to your interactive 
presentation.

Close Polling Closes polling and prevents 
participants from providing 
responses to your interactive 
presentation.

Repoll 
Question

Clears the responses and 
accepts new responses from 
the audience for the currently 
displayed question. Both the 
original responses and the new 
responses are stored in the 
session file.
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Toggle 
Results

Changes the values displayed 
on each chart. The values can 
be represented as either 
numbers or percents.

Show the 
Response 

Grid

Opens a Response Grid on the 
screen allowing you to see 
which participants have 
responded to the question.

The size, location, visual 
display and contents of the grid 
are controlled using the 
controls in the Presentation 
Settings. Find more information 
about settings in Establish the 
Presentation Settings on 
page 193.

Show Non-
Response 

Grid

Opens a Non-Response Grid 
on the screen. As each 
participant responds, their 
response box is removed from 
the grid.

Display 
Participant 

Monitor

Opens the Participant Monitor. 
Find more information in the 
Use the Participant Monitor 
on page 203.

Show/Hide 
Feed Back 

and 
Messaging

Opens and/or closes Feedback 
and Messaging.

Display 
interactive 

results

Expands the Showbar to 
display the responses, user 
feedback, and polling status. 

Insert Slide Opens a drop-down menu and 
allows you to select the slide 
type to be inserted into the 
presentation.



200 Turning Technologies

Chapter 7: Run Presentations

2 Click the mouse to control the 
progress of the slide show. 

The control of each slide will vary slightly depending on the 
objects you choose to insert when you create the slides. Find 
information on slide objects and their behavior in Add Objects 
on page 84.

Optionally, you can press the N key, Return, Right Arrow, Down 
Arrow, Enter, or the Space Bar to control progress.

a Open polling. Select the 
Play button from the 
Showbar to open polling.

TurningPoint receives responses when polling is open.

Polling Open

b Select the Stop button to 
close polling and display 
the results.

No responses are accepted when polling is closed.

Polling Closed

c Click again to advance to 
the next slide.

3 Click at the end of the slides 
to exit from the Slide Show 
(or optionally, press the Esc 
key).

If you exit the TurningPoint, the program prompts you to name 
and save the session results to a file. The default location is 
Documents/TurningPoint/Sessions. If you choose the default 
name, TurningPoint adds the date and time to the file name. If 
you choose to name it specifically, the name you chose is 
stored.

Note To advance slides, you may use any method 
PowerPoint allows, such as clicking the mouse 
or pressing the space bar, arrow keys, or Enter 
key.

Tip Store your session file in the Sessions folder 
suggested by TurningPoint to allow the session 
file to be used again by TurningPoint to restart 
sessions or generate reports. Find information 
about reports in Reports on page 211.
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View Polling Status

TurningPoint provides three mechanisms to see how many participants have responded to the 
question when polling is open. You can expand the Showbar to see how many responses are 
received. You can display a Response Grid, or you can open the Participant Monitor to see the full 
details of the audience response.

This section describes using the expanded Showbar and the Response Grid to view participant 
results. Find more information about the Participant Monitor in Use the Participant Monitor on 
page 203.

Step by Step Instructions To view the polling results…

1 On the Showbar, select the 
Down Arrow button. 

The Showbar expands to display four additional regions that 
allow you to insert a slide and show the polling status. After 
everyone submits a response, the number in the Responses 
column equals the total number of participants.

Showbar Expansion

Down Arrow 
button

Expands the Showbar to 
display the responses, user 
feedback, and polling status. 
The Showbar also becomes 
fully visible on the slide.

Insert Slide drop-
down menu

Allows you to insert a slide 
during an interactive 
presentation.

Responses Identifies the number of 
responses received from the 
audience. This area is not 
visible when the slide show 
starts.

Feedback With vPad devices, shows the 
typed questions. With 
ResponseCards, shows the 
presses of the question mark 
key.
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This step may meet all your needs for viewing polling status. 
You also have the option to use the Response Grid explained in 
step 2, especially if you use infrared ResponseCards.

2 Optionally, display a 
Response Grid during the 
session. From the Showbar, 
select the Show Response 
Grid button.

The Response Grid is a grid that is overlaid on a slide during the 
presentation and indicates which individuals enter responses. 
Similarly, the Non-Response Grid indicates which participants 
have yet to respond. Specifically helpful to participants using 
infrared devices, these grids give the participants confirmation 
that their responses were received. Radio frequency and vPad 
devices display confirmation right on the device.

Response Grid

The Response Grid can be shown or hidden at will by selecting 
the Show Response Grid button. When this button is selected, 
an interactive slide displays the Response Grid when the 
question is first presented. The Response Grid is removed 
when polling is closed. 

3 After you close polling, click 
the mouse to advance to the 
next slide.

Viewing the polling status becomes disabled in the Showbar 
until you activate another poll. If you want to always display the 
Showbar expansion, set the Expand Showbar setting to True. 
Expand Showbar is a presentation-level setting. Find more 
information about modifying settings in Response Device and 
Settings Management on page 97.

Polling Identifies whether polling is 
open or closed. The 
background of this region is 
green when polling is open and 
red when closed. This area is 
not visible when the slide show 
starts.



TurningPoint User Guide 203

Run a Presentation

Use the Participant Monitor

The Participant Monitor shows which participants have responded to a question and displays details 
about the responses, such as the percentage of correct responses, how long participants took to 
respond, and which answers they chose. Use of the Participant Monitor is optional, but it is helpful if 
you would like to keep track of how people are responding during your presentation.

You can access the Participant Monitor from the Showbar while the slide show is running, or from the 
TurningPoint toolbar under the Participants drop-down menu after you end the slide show. 

Step by Step Instructions To monitor participants…

1 While running the slide show, 
from the Showbar select the 
Display Participant Monitor 
button.

Select Display Participant Monitor

Alternatively, you can display the Participant monitor after 
running a slide show by selecting Participants > Display 
Participant Monitor from the TurningPoint toolbar.

Participant List Menu: Display Participant Monitor

Note If you want to limit the Participant Monitor to 
your eyes only, then you can set up a second 
monitor for displaying it. Find information about 
setting up a second monitor in Mac Help and 
Chapter 4: Response Device and Settings 
Management. 
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TurningPoint opens the Participant Monitor window displaying 
Question, Participant, and Individual details about each 
participant’s response and the percentage of correct answers. 

Participant Monitor Window

The Question Region lists all of the questions and the Overall 
percentage correct for the group and the total point value per 
question.

Participant Monitor Window: Question Region

The Participant Region lists the specific responses chosen by 
the participant, overall percentage of correct answers, total 
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points accumulated, and the response time and response for 
the question selected in the Question Region.

Participant Monitor Window: Participant Region

The Individual Region lists details about the response results for 
each participant for each question in the presentation. 

Participant Monitor Window: Individual Region
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2 Optionally, you can expand 
or reduce the size of the three 
regions by selecting the 
borders and dragging them 
up or down. 

Add Slides During a Presentation Session

TurningPoint gives you the flexibility of adding a template or custom slide while running the 
presentation. Inserting a new slide is an option available at your fingertips through the Showbar. 

Step by Step Instructions To add a new slide…

1 Insert a new slide in one of 
the following ways:

• Template Slide - select the 
Insert Slide drop-down 
menu on the Showbar, 
select the type of slide.

A drop-down menu opens from the Showbar allowing you 
to select the slide type to be inserted into the 
presentation.

The slide is automatically inserted.

Showbar Expansion: Insert a Template Slide
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• Custom Slide - select the 
Insert Slide drop-down 
menu on the Showbar, 
select Custom, and go to 
step 2.

 Showbar Expansion: Insert a Custom Slide

The Custom Question window opens to display the fields 
for typing the question and answer choices to be used on 
the interactive slide.

 Insert Slide: Custom Question
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2 Enter the question in the top 
region of the window. Enter 
the answer choices in the 
lower region, separating each 
answer with a line break.

 Insert Slide: Custom Question

3 Select the Add button. TurningPoint adds a new interactive slide, after the slide you 
have been viewing. 

Note If you would like to reuse the presentation with 
the newly added slide, save the file. From the 
PowerPoint menu, select File > Save As. If you 
forget, TurningPoint asks you before closing.
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Where Do I Go From Here?

This chapter has demonstrated how to run and manage presentations.

You are now ready to begin reviewing reports and understanding presentation data. You can find 
information in Chapter 8: Reports.
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Reports

Turning Reports allows you to generate and view a wide variety of reports based on the responses 
you received during your TurningPoint and TestingPoint sessions. The reports are generated as 
printable Word documents or Excel worksheets with information about the questions and answers, 
participants, and responses gathered in your presentation. Turning Reports displays a hierarchical 
menu of reports organized by category, such as Results by Question Reports and Demographic 
Reports. If you click on one of these categories, the Turning Reports screen displays subheadings of 
specific report titles, and shows samples of each selected report.

Twenty reports are available for reporting on the entire audience, by individual participants,  by 
standards, and on the basis of demographics. If you have specified correct answers or point values, 
you can “grade” participants, verify that standards are met, and provide valuable feedback to 
participants.
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View a Report

You can create reports using Turning Reports available in the Tools menu in the TestingPoint toolbar.

This section describes how to:

• View a Report

View a Report

Use Turning Reports to generate reports.

Before You Begin

Create a session file by running a presentation session. Find more information in Chapter 7: Run 
Presentations.
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Step by Step Instructions To view a report…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Turning Reports

2 Select Turning Reports from 
the Tools menu.

The Turning Reports window opens and displays a list of the 
session files in your Sessions folder.

Turning Reports: Select Session



214 Turning Technologies

Chapter 8: Reports

You also have the option of navigating to a session file you have 
stored elsewhere on your computer.

3 Choose a session file.

4 Select Open. The Turning Reports window displays a list of the categories of 
reports you can generate from your session file.

Turning Reports: Generate Reports

Each category of report is listed by name. You can select the 
category or click on the triangle beside the category to view a 
list of reports in each category. 

When you select a report, you can see a sample preview of the 
report on the right-hand side of the Turning Reports window.

5 Select the type of report(s) 
you would like to generate by 
selecting the report name.

Find more information in Reports on page 211.

6 Select the Generate Report 
button.

TestingPoint generates the report(s) and opens it in Microsoft 
Excel or Word, which ever is appropriate.
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This may take some time, especially if you selected to generate 
a large number of reports or if there are a large number of 
questions or participants in the session.

You can generate as many reports as you like. When one report 
is finished being created, select another type of report from the 
list and select the Generate Report button again.

7 When you are finished 
creating reports, close the 
Turning Reports window. 

Next Steps

You can use Excel or Word to edit, save, or print the reports.

Note If you selected to generate multiple reports, 
one Excel file is created with worksheets for 
each report. 

Note Alternatively, you can generate a report by 
double clicking on the report name. Only that 
report will be generated. Any other reports 
that were selected will have to be generated 
by double clicking each report or selecting 
the Generate Report button to generate them 
all.
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Types of Reports

This section describes:

• Results by Question Reports (2 Reports)

• Demographic Reports (2 Reports)

• Participant Results Reports (4 Reports)

• Participant List Reports (2 Reports)

• Standards Reports (2 Reports)

• Comparative Scoring Reports (2 Reports) 

• Percentile Reports (2 Reports) 

• Other Reports (4 Reports)

• Attendance Report

• Participant Questions and Comments Report

• Response Data Export Report

• Statistics Report
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Results by Question Reports
The Results by Question Reports and Graphical Results by Question show a summary of responses 
for each question. Each of these reports creates an Excel file.

Results by Question Report The report includes the following information for each question:

• the answers

• an indication of the correct answer(s)

• the number of responses for each answer

• the percentage of responses for each answer

Results by Question Report
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Graphical Results by
Question Report

The report includes the following information for each question:

• the answers

• an indication of the correct answer(s)

• the number of responses for each answer

• the percentage of responses for each answer

• pie chart with a percentage of the responses per answer

Graphical Results by Question Report
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Demographic Reports
The Demographic Comparison and Graphical Demographic Comparison Reports show a summary of 
responses for each question broken down by demographics. Each of these reports creates an Excel 
worksheet.

Demographic Comparison The Demographic Comparison Chart includes the following 
information for each question:

• the answers 

• indication of the correct answer(s)

• the number of responses for each answer from each 
group

• the total number of responses from each group
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• demographically categorized response data on a per 
question basis

Demographic Comparison

Graphical Demographic
Comparison

The Graphical Demographic Comparison includes the following 
information for each question:

• the answers

• an indication of the correct answer(s)

• the percentage of responses for each answer from each 
group
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• a vertical bar chart of the responses for each answer from 
each group

Graphical Demographic Comparison
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Participant Results Reports
The Participant Results, Graded Participant Results (correct/incorrect), Graded Participant Results 
(point values), Graded Participant Results (ratio) Reports show a detailed question by question 
breakdown of responses. When generating these reports you have the option of displaying the entire 
question or excluding the question text. Each of these reports creates an Excel worksheet.

Participant Results Report The report includes the following information for each 
participant: 

• Device ID 

• fields defined in the Participant List

• the numerical value of the participant’s response to each 
question

Participant Results Report
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Graded Participant Results
(correct/incorrect) Report

The report includes the following information for each 
participant: 

• Device ID 

• fields defined in the Participant List 

• the numerical value of the participant’s response to each 
question

• an indication of whether the response is correct or 
incorrect

• total percent correct 

Graded Participant Results (correct/incorrect) Report
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Graded Participant Results
(point values) Report

The report includes the following information for each 
participant: 

• Device ID 

• fields defined in the Participant List 

• the numerical value of the participant’s response to each 
question

• an indication of whether the response is correct or 
incorrect

• the total number of points 

Graded Participant Results (point values) Report
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Graded Participant Results
(ratio) Report

The report includes the following information for each 
participant: 

• Device ID 

• fields defined in the Participant List 

• the numerical value of the participant’s response to each 
question

• an indication of whether the response is correct or 
incorrect

• the ratio of correct to total number of answers for each 
question 

Graded Participant Results (ratio) Report
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Participant List Reports
The Participant List Reports show the participant data from the Participant List in either an Excel 
worksheet or a Word document. 

Participant List (Excel)
Report

The report shows Device ID and any of the fields defined in the 
Participant List (name, contact information, demographic 
groups or teams, etc.)

Participant List (Excel) Report

Note If you selected to generate the Word 
document version of the Participant List 
along with any other report, the Word 
document is included as a worksheet in the 
Excel file.
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Participant List (Word)
Report

The report shows Device ID and any of the fields defined in the 
Participant List (name, contact information, demographic 
groups or teams, etc.)

Participant List (Word) Report
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Standards Reports
The Overall and Individual Standards Reports show response information based on standards 
identified for each question. Each of these reports creates an Excel worksheet.

Overall Standards Report The Overall Standards Report is very similar to the Results by 
Question Report but includes additional information relating to 
standards. It includes the following information for each 
standard:

• the percentage of overall comprehension for all questions 
that are associated with the standard

• the questions associated with the standard

• the answers for each question

• an indication of the correct answer(s)

• the number of responses for each answer
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• the percentage of responses for each answer

Overall Standards Report

Individual Standards Report The Individual Standards Report includes the following 
information for each individual participant for each standard:

• the participant’s percentage of comprehension for all 
questions that are associated with the standard

• the questions associated with the standard

• the answers for each question

• an indication of the correct answer(s)
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• an indication of the participant’s response and whether it 
was correct

Individual Standards Report
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Comparative Scoring Reports
The Individual Scoring and Scoring Distribution Reports show a summary of scoring information 
based on participant responses in comparison to other participants. Each of these reports creates an 
Excel worksheet.

Individual Scoring Report The Individual Scoring Report includes the following information 
for each participant:

• numeric response labeled correct or incorrect 

• question’s overall percentage correct 

• whether the participant’s score puts him/her above or 
below the class average 

Individual Scoring Report



232 Turning Technologies

Chapter 8: Reports

Scoring Distribution Report The Scoring Distribution Report includes the following 
information: 

• the total number of participants

• the score ratios for assessment (number of correct 
answers to questions)

• the number of participants achieving each score ratio

• the answer value (correct, incorrect, points, no value)

• acceptable answer choices

• number of responses each answer received

Scoring Distribution Report
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Percentile Reports
The Percentile (correct/incorrect percentage) and Percentile (points) Reports show how participants’ 
responses compared to other participants’ responses, Device ID, first and last name, and the 
percentile ranking for each correct an answer for each participant group by percentiles. You can 
change the percentiles shown by recording the new percentiles separated by a semicolon in the 
appropriate box. Each of these reports creates an Excel worksheet.

Percentile (correct/incorrect
percentage) Reports

The Percentile (correct/incorrect percentage) Report includes 
the following additional information:

• the total percentage of questions each participant 
answered correctly 

Percentile (correct/incorrect percentage) Reports

Percentile (points) Report The Percentile (points) Report includes the following additional 
information:
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• the total points accumulated by each participant

Percentile (points) Report
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Other Reports
TurningPoint offers four unclassified reports: Attendance, Participants Questions and Comments, 
Response Data Export, and Statistics Reports. Each of these reports creates an Excel worksheet. 

Attendance Report The Attendance Report provides basic participant information, 
including name and Device ID, and shows who has attended the 
presentation.

Attendance Report

Participant Questions and
Comments Report

The Participant Questions and Comments Report shows any 
comments or questions sent by any participants during the 
presentation. The report includes the following additional 
information:

• time the presentation started and ended

• time the slides were polled
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• time the presenter sent information to vPad users

• time any participant sent a question or comment or 
indicated that they had a question or comment

Participant Questions and Comments Report
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Response Data Export Report The Response Data Export Report gives the raw response data. 
It creates a table of values displaying the numerical response 
values for each Device ID.

Response Data Export Report
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Statistics Report The Statistics Report shows the overall correct percentage per 
participant versus mean and median.

Statistics Report
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Where Do I Go From Here?

This chapter has introduced the various report types and has demonstrated how to view these 
reports.

You are now ready to begin managing sessions. You can find information in Chapter 9: Sessions.
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TurningPoint creates session files whenever you run a TurningPoint presentation. When you save a 
session, TurningPoint automatically includes the PowerPoint presentation with your TurningPoint file. 

The session results are stored temporarily during a session. You can save the session results to a file 
to access them later. This chapter provides instructions for accessing and managing your 
TurningPoint sessions through Turning Reports. 
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Recall the five steps to presentation success:

Five Steps to Success

This chapter discusses how to save and manage sessions. 
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Manage Sessions

This section describes how to: 

• Save Results from a Session

• Change the Default Save Location

• Continue a Previously Saved Session

• Delete Results from a Session

Save Results from a Session

TurningPoint can quickly save a session so it is available for retrieving the results or resuming the 
session later.

Before You Begin

Identify a reliable location on the computer or on a data storage device where you would like to save 
the presentation. 

Step by Step Instructions To save a session…

1 From the Slide Show view, 
click the screen. Select End 
Show.

TurningPoint concludes the presentation.

2 From the TurningPoint 
toolbar, select the Save 
Session button. 

Save Session

TurningPoint displays the Save Session dialog that shows the 
file name, file type, and where the file will be saved. The default 
location is Documents/TurningPoint/Sessions. If you choose 
the default name, TurningPoint adds the date and time to the file 
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name. If you choose to name it specifically, the name you chose 
is stored. 

Save Session Dialog Box

If you wish to change the default location, select a file folder to 
save the session and give the session a file name. To 
permanently change the default location, go to Change the 
Default Save Location on page 244.

3 Select the Save button. TurningPoint saves the file in the designated location.

Change the Default Save Location

Change the default save location for your TurningPoint folder. This changes the save location of your 
session files, Participant Lists, and standards.

Before You Begin

Identify a reliable location on the computer where you would like to save your TurningPoint 
documents.
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Step by Step Instructions To change the default save location…

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window

2 Select the Settings tab from 
the Settings window.

3 Select Application from the 
Settings Hierarchy.

Settings Window: Application Settings



246 Turning Technologies

Chapter 9: Sessions

File Location is the first setting listed under the Application 
Settings Heading.

4 Select Change. A dialog opens allowing you to choose a file location. 

Default Save Location Window

5 Select a new default location. 

6 Select Open. Your TurningPoint folder location has been changed.

Note You can restore your save location to the 
default settings by selecting Reset All 
Settings. This will reset all settings to the 
default.
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Continue a Previously Saved Session

TurningPoint can resume your presentation using a saved session file. TurningPoint appends new 
session information to the opened session file, allowing you to save the polling results for the 
presentation in one file.

Before You Begin

If the session file is saved on an external storage device, insert the device into the computer. 

Locate the session you wish to open. On the computer that is running the presentation, the default 
location for saved sessions is Documents\TurningPoint\ Sessions. 

Step by Step Instructions To continue a previously saved session…

1 From the TurningPoint 
toolbar, select the Continue 
Prior Session button. 

Continue Prior Session

TurningPoint displays the dialog that shows the file name, file 
type, and where the file is located. The default location is 
Documents\TurningPoint\Sessions.

2 Navigate to the file you wish 
to open and select the Open 
button. 

TurningPoint opens the previously saved file.

Next Steps

From the TurningPoint toolbar select the Start a TurningPoint Slide Show button.  Advance to the slide 
from which you want to resume your presentation. Continue presenting the session.
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Delete Results from a Session

You can use the same presentation to create a new set of responses. The Reset menu on the 
TurningPoint toolbar gives you the option of deleting the results in order to redo a session or present 
a new session. You also have the option to redo only one question slide in a session.

Before You Begin

If you want to view the results at a later time, save the session before proceeding with the following 
steps. 

Step by Step Instructions To delete the results from a session or a single slide…

1 Open the presentation. To 
delete the results of one 
question only, select that 
slide.

Note  You cannot undo the Reset function, so be 
certain that you wish to delete the results.
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2 From the TurningPoint 
toolbar, select the Reset 
menu.

The Reset menu opens offering the options to reset either the 
entire session, all the slides or simply the current slide. 

Reset Session

3 When you are ready to delete 
the results, select either 
Session, All Slides or Current 
Slide. 

• Selecting Session resets every slide in the presentation 
by resetting the values to zero on all slides and clears all 
of the results data from the temporary session file by 
removing all of the response and participant data.

• Selecting All Slides resets every slide in the presentation 
by resetting the values to zero on all slides.

• Selecting Current Slide resets the currently viewed slide 
only by resetting the values to zero on that slide.

Note Be certain that you wish to delete the results! 
You cannot undo the Reset function for either 
the Session, All Slides or Current Slide options. 
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Where Do I Go From Here?

This chapter has demonstrated how to save and continue sessions and manage session data.

This user guide has introduced you to the process of creating interactive presentations with 
TurningPoint. You have learned how to successfully build, deliver, and save the results of an 
interactive presentation in five easy steps.

You have customized the slides and included animation, feedback mechanisms, and excitement in 
your presentation. You have also created reports to view the results of your presentation session.

If you have further questions about the TurningPoint system, please feel free to contact Customer 
Support at Turning Technologies. See “Customer Support” on page 17.
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Answer

An Answer is one of a list of choices on a TurningPoint slide. 
The answers are enumerated and participants’ responses 
correspond to the number of the answer.

Answer Now Indicator
An Answer Now Indicator is an object on a TurningPoint slide 
that gives the audience a visual indication that polling is open 
and they should respond to the question.

Answer Region
The Answer Region is the area on a TurningPoint slide that 
contains the list of answers.

Answer Value
For purposes of scoring, you can assign answer values to 
answers on a TurningPoint slide. The possible values are 
“correct”, “incorrect”, “no value,” or a point value zero through 
10,000.

Chart
A chart is a visual representation of the results of polling on a 
TurningPoint slide.

Correct Answer Indicator
A Correct Answer Indicator is an object on a TurningPoint slide 
that gives a visual indication of the correct answer(s) after 
polling has closed.

Device ID
The Device ID is a number that uniquely identifies a response 
device. For hardware devices, it may be printed on the tag on 
the back of the device. For vPad, it is embedded in the 
application.
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Essay Slide
An Essay slide asks an open-ended question. ResponseCard 
IR, XL, and RF users are limited to numerical responses, but 
ResponseCard XR and vPad users may provide alphanumeric 
responses of varying lengths.

Fill in the Blank Slide
A Fill in the Blank slide asks a question or makes a statement 
with a missing word. Types of responses are determined by the 
type of device a participant is using. For instance, 
ResponseCard IR, XL, and RF users are limited to numerical 
responses, but ResponseCard XR and vPad users may 
provide alphanumeric responses of varying lengths.

Infrared (IR)
Infrared light is invisible to the human eye and can be used to 
transmit information. Some of the response devices that work 
with TurningPoint use infrared technology. IR devices require a 
direct line of sight to the receiver. The IR response devices 
allow only one-way communications.

Parser
A parser examines a file and breaks it into logical units to use 
and recombine. The TurningPoint Parser can take several 
kinds of files and create TurningPoint presentations from them.

Participant List
A Participant List is the file used during a session to match 
participant information with the response device used. Users 
can customize the type of participant information/data fields to 
include in the list but every list will include a field for the Device 
ID.

Participant List Assistant
The Participant List Assistant is a tool that guides you through 
the creation of a Participant List to be used with your 
presentation session.

Participant Monitor
The Participant Monitor displays the status and information 
pertaining to the participants’ responses to all of the questions, 
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including the total percentage of correct responses, which 
answers they picked, and individual overall points and 
percentage scored. 

Participants
The people in the audience of a presentation who use the 
response devices to respond to questions.

Picture Slide
A picture slide is a TurningPoint slide in which the answer text 
is replaced with pictures.

Polling
Polling is the mechanism by which TurningPoint accepts and 
tallies the responses provided by the audience using 
Response Devices.

Presentation Session
See Session.

Radio Frequency (RF)
Radio frequency devices use radio waves to transmit 
information. Some of the response devices that work with 
TurningPoint use radio frequency technology. RF devices do 
not require a direct line of sight. The RF response devices use 
two-way communications, so the response device can confirm 
that a response was received by the receiver.

Receiver
A receiver is a device that attaches to your computer to receive 
IR or RF signals from response devices.

Report
Reports present session data in a variety of useful ways 
allowing you to analyze that data. You can generate reports 
from a session using Turning Reports.

Reset
To return the response tallies from the audience to zero.
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Response
A response is the signal received from a participant during 
polling. The response usually corresponds with one of a list of 
answers on the slide.

Response Grid
A Response Grid is available from the Showbar and is used to 
show which participants have responded to a question.

ResponseCard
A ResponseCard is a type of hardware response device that 
use infrared (IR) or radio frequency (RF) signals to 
communicate a participant’s response.

Session
A session is a run-through of an interactive presentation where 
an audience has submitted responses to some or all of the 
questions.

Session File
A session file is created to store the results and other data 
when you run a session. Session files are usually stored in 
Documents\TurningPoint\Sessions and have extension .tpz.

Showbar
The Showbar is a toolbar that provides activation buttons for 
polling, monitoring, and viewing responses during the slide 
show.

Slide Show
A slide show is a presentation created in PowerPoint, which 
may or may not include TurningPoint slides.

Standard
A standard is any framework for the evaluation of participants. 
You can assign standards to slides in a TurningPoint 
presentation to compare participants’ performance to a 
standard.
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Statistic Indicator
A Statistic Indicator is an object on a TurningPoint slide that 
shows the mean (average), median, standard deviation, or 
variance of responses after polling has closed.

Text Messaging
Text Messaging is a feature for sending messages to 
participants using vPad during a presentation.

TurningPoint Slide
TurningPoint slides are slides in a PowerPoint presentation 
with the ability to dynamically display information based on the 
responses of an audience.

TurningPoint Toolbar
A series of menus and buttons displayed below to the 
PowerPoint toolbars that contains the tools for using the 
TurningPoint software.

vPad
A vPad is a software version of a response device that is set up 
for use in Settings. It can be installed on a networked computer 
or Smart Device.

XML
XML is a markup language for text files, similar to HTML, that 
is used by TurningPoint for storing session data and as an 
import format for the TurningPoint parser.



256 Turning Technologies

Glossary



TurningPoint User Guide 257



258 Turning Technologies

Glossary



TurningPoint User Guide 259

Frequently 
Asked Questions

This appendix offers you a quick reference to common questions that customers have about using the 
TurningPoint software. If you do not find an answer to your question here, visit the Turning 
Technologies web site at http://www.turningtechnologies.com or call a Turning Representative toll-free 
at 1-866-746-3015.

Why can’t I install TurningPoint?
You must be the local administrator to install TurningPoint for 
the first time using the administrative username and password. 

Where is my product serial number (activation 
code)?

The product serial number, also called the activation code, is 
located on a label inside the ResponseCard Kit. 

Which response devices are compatible with 
TurningPoint?

Turning Technologies partners with Responsive Innovations to 
provide audience response devices that are specifically 
designed to support the functionality of TurningPoint. The 
ResponseCard IR, ResponseCard XL, ResponseCard RF, and 
ResponseCard XR from Responsive Innovations are products 



260 Turning Technologies

Appendix A: Frequently Asked Questions

that are optimally suited for use with TurningPoint. Users also 
have the option of using TurningPoint’s vPad application for 
using a virtual keypad. 

How do I set up the response devices?
All of the response device settings can be found in the Settings 
windows. From the TurningPoint Toolbar, select the Tools > 
Settings. Find information about Installing Response Devices in 
Chapter 4: Response Device and Settings Management.

Where should I put the receiver?
Because the IR device uses infrared technology and line-of-
sight communication, place it in a central location in the front of 
the room where it is high enough for everyone to see. The 
effective range of an IR device receiver is about 90 feet (27 
meters). You will need to install one receiver for every 80 
participants. The effective range of a ResponseCard RF is 
about 200 feet (60 meters) and the ResponseCard XR is about 
400 feet (120 meters). A single receiver is sufficient for up to 
1000 ResponseCards, and a direct line of sight between the 
receiver and the ResponseCard is not necessary. When the 
receiver is connected, the participant has to simply press the 
number or letter on the ResponseCard to send a response. 
Find information about setting up the receiver in Chapter 4: 
Response Device and Settings Management.

Why is a ResponseCard not working?
The correct ResponseCards may not be matched with the 
receiver. Check your response device settings. Find 
information about the response device settings in Chapter 4: 
Response Device and Settings Management.

The ResponseCard’s batteries may be too low or dead. Press a 
button on the ResponseCard. The light on the ResponseCard 
blinks or does not light up if the batteries need to be replaced. 

The ResponseCard may not be correctly programmed. Refer to 
the Programming ResponseCards insert in the TurningPoint kit.

How do I track responses from participants?
Create a Participant List in TurningPoint and then use the 
Participant Monitor to view the responses from each 
participant. You can either create a Participant List using the 
Participant List Assistant or by importing an existing file. Find 
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information about Participant Lists in Chapter 5: Track 
Participants. Find information about the Participant Monitor in 
Chapter 7: Run Presentations.

How do I clear data from a session or a slide?
From the TurningPoint Toolbar, select the Reset menu, and 
then select Session or Current Slide from menu. Find 
information about working with sessions in Chapter 9: 
Sessions.

How do I save a session?
From the TurningPoint Toolbar, select the Save Session button, 
which looks like a disk. A window opens allowing you to select 
a file name and location. Save the file in the Sessions folder, 
located at Documents > TurningPoint > Sessions. Find 
information about saving a session in Chapter 9: Sessions.

How do I make a report with the data from my 
session?

TurningPoint enables you to create several types of reports. 
Find information about your options and instructions for 
creating reports in Chapter 8: Reports.
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